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About this Book 
The Patran User’s Guide is a step-by-step introduction to using Patran. This guide is for designers, engineers, 
and analysts new to Patran. Understanding and using the information in this guide requires no prior 
experience with CAE or finite element analysis.

The purpose of the guide is to give you the essential information you need to immediately begin using Patran 
for real-life analysis projects. As you read it, keep in mind that there are many capabilities and methodologies 
not covered here. Once you have mastered the fundamentals of Patran, you will be ready to tackle the more 
advanced features and methods covered in other books

How the Book is Organized
The guide is organized into ten chapters. Chapters 1 and 2 present the fundamentals of Patran. Chapters 3 
through 10 explain how to use Patran to complete the tasks in CAE projects. 
 

Chapter 1
Introduction

Chapter 1 presents a brief overview of CAE and Patran. It also outlines the 
specific tasks in CAE projects.

Chapter 2
Fundamentals

The first part of this chapter covers the features and functions of Patran. 
The second part of the chapter introduces you to the graphical user 
interface and illustrates how to use various menus and tools.

Chapter 3
Creating and Maintaining a 
Database

Chapter 3 details how to create a model database. It goes on to cover three 
basic functions of a database: storing information, importing CAD data, 
and setting the parameters of a model.

Chapter 4
Turning Product Designs 
into Geometry

Patran provides its own set of tools for creating and editing geometry 
models. This chapter explains how you can use these tools to quickly create 
parts with two- and three-dimensional wireframe, surface, and solid 
geometry. 

Chapter 5
Meshing and Creating 
Elements

Once the geometry model has been built, create and verify a finite element 
mesh using a powerful suite of meshing tools. Chapter 5 describes how to 
select and use the appropriate meshing tool.

Chapter 6
Defining Materials in the 
Model

With a meshed geometry model, you describe what your model is made of 
(such as steel or a composite) and the attributes of that material (stiffness, 
density, and so on). This chapter guides you through defining the 
materials. 

Chapter 7
Applying Forces and Loads

Chapter 7 discusses how to apply environmental conditions to your 
model. The finite element analysis uses this information to test the model’s 
reaction to the applied loads when constrained by the applied boundary 
conditions. 

Chapter 8
Generating Finite Elements

You must tailor the meshed geometry model to fit the formats and 
specifications of a selected analysis code and analysis type. Chapter 8 
explains how you define element types (such as beam, shell, and so on) and 
element-related properties for your model.



xiiiPreface
Beginning with Chapter 3, there are three sections to each chapter: an overview, a discussion on concepts, 
and instructions on using Patran menus and forms to carry out tasks.

Case Studies
To better illustrate the basic and more advanced capabilities of Patran, there are three case studies included 
in this Guide. Each case study looks at a unique analysis problem and steps through a solution sequence using 
Patran.

You may find it helpful simply to follow each case study from start to finish as you encounter them 
throughout this Guide. As an alternative, the overview chart below can help you link directly to a specific task 
you may want to see. 
 

Chapter 9
Running a Finite Element 
Analysis

This chapter details the link between the Patran modeling environment 
and the analysis solvers. It also provides instructions for setting up and 
submitting analysis cases.

Chapter 10
Visualizing Numerical 
Results

Chapter 10 explains how to use different tools to quickly visualize 
numerical results. 

Case Study #1 - Annular plate located at the end of Chapter 1

This case study illustrates a complete start to finish analysis of an annular plate. A 2D membrane model 
is created in Patran to represent the plate’s 3D geometry and an MSC Nastran linear static analysis of the 
plate under static pressure loading is carried out. Analysis results are compared to theoretical results.

To See How To: Go To:

Model  Create Native Geometry in Patran page 14

 Mesh a 2D surface with Quad4 elements page 16

 Manually input isotropic material properties page 19

 Apply a constant edge load page 20

Analysis  Set up a MSC Nastran linear static analysis page 23

 Initiate a full analysis run page 23

Results  Retrieve the analysis results page 25

 Create a quick plot of the results page 26

Case Study #2 - Lug located at the end of Chapter 4

The 3D geometry of a steel lug is imported into Patran from a Parasolid CAD file. A 3D analysis model 
is then created with Patran. TetMesh is used to create 3D solid elements and the fields capability is 
illustrated by applying a load using a PCL function. A linear static MSC Nastran analysis is performed and 
standard fringe and deformation plots are generated.

To See How To: Go To:

Model  Import a CAD Model into Patran page 85
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 Mesh a 3D Solid with Tet10 elements page 86

 Use Fields and PCL to define a load page 89

Analysis  Run a linear static analysis using MSC Nastran page 95

Results  Generate quick plots of the analysis results page 96

Case Study #3 - Coffee Cup located at the end of Chapter 7

In this final case study, a complete analysis model is imported from a MSC Nastran Input file. The first 
task is to view the existing boundary conditions and pressure loads. Then a change is made to the loading 
conditions and a MSC Nastran analysis is repeated. Resulting fringe and deformation plots are viewed.

To See How To: Go To:

Model  Import a MSC Nastran Input file page 160

 View and modify pressure loads page 162

Analysis  Run a linear static subcase in MSC Nastran page 164

Results  Produce quick plots of the analysis results page 166
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Virtual Product Development
Virtual Product Development (VPD) is an approach that takes a design at the earliest concept stage and fully 
evaluates design specifications and usage scenarios, and then uses this information to guide the development 
process. Across industries, VPD enables companies to leverage resources by optimizing product designs 
leading to improved performance, reduced need for real-world prototypes, verifiable quality improvements, 
and minimized operational problems and failures.

VPD continues to expand in its usefulness and application adding new efficiencies to product development 
processes. These efficiencies have become a key factor in an organization’s success in today’s marketplace.

VPD and Simulation Software
At the core of the VPD process is the capability to use simulation software to represent physical environments 
and events in evaluating the operability of a product design. Simulation begins with building a model of the 
product structure and generating a simulation of its operating environment. Then, using specialized 
simulation software called finite element analysis (FEA) codes, the simulation model is analyzed to determine 
how it responds to the imposed environment. This response is then measured against allowable limits, test 
data, and knowledge databases.

Finite element analysis codes use sophisticated structural analysis techniques to predict the response of a 
model. A simulation model submitted to an FEA code for evaluation must be broken into small units called 
finite elements. The code then applies fundamental engineering principles to calculate the response of the 
model. Finite element software codes can provide answers to a vast array of continuum mechanics problems. 
How much tension, compression, bending, twisting, or vibration does a product endure? 
How hot or cold does a structure get? Do the materials change over time as they become hotter, colder, or 
they deform?

Finite element technology predicts the behavior of even the most complex structures. As a designer or 
engineer, it is not necessary to have a detailed knowledge of the mathematics behind this technology. Instead, 
you must be able to define the engineering problem by building a simulation model that accurately represents 
the product design. This involves modeling the dimensions and parts of the product, specifying what the 
product is made of, and defining the environment in which the product operates.

Interfacing with CAD and Vertical Applications
For many organizations the VPD process must be tightly integrated with the CAD processes implemented 
in the design stages. It is the product design data detailing dimensions, geometry, parts, and assemblies 
generated from a computer-aided design (CAD) process that are the building blocks for the simulation 
model. 

VPD depends on CAD to define product design and in return CAD receives feedback from VPD verifying 
the quality of the product design. In some instances the simulation is required to be carried out within the 
CAD environment. MSC offers multiple options for interoperablity between CAD and the VPD process.

Integration in the vertical application area further defines the value added benefits VPD. Products, like 
Patran, vertically integrate the processes of building, testing, and validating new product designs.
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A First Look at Patran
Patran lets you manage and carry out several phases of the VPD process in one place. It is a product design 
model builder, an environment simulator, a finite element analysis manager, and a numerical results 
interpreter all in one. You can use Patran by itself to complete all of your simulation tasks, or you can use it 
in conjunction with other CAD software, modeling packages, and analysis codes. 

Before you embark on learning to use Patran, briefly look behind the scenes. Understanding how Patran is 
put together makes it easier to apply its many capabilities. 

Five key features form the foundation for Patran and a unique infrastructure, linking these features, gives 
Patran power and versatility.

Task Interface
The Task Interface is what you see on the screen when you use Patran. The interface includes menus and 
toolbars for using tools and applications, forms for inputting data, icons for showing the status of operations, 
and viewports for rendering computer models. The interface provides access to all the functions and 
capabilities of Patran. 

Tools and Applications
The Tools and Applications are the mainstay of Patran. Tools help you carry out tasks inside Patran. There 
are literally hundreds of tools that help you create product simulations, set up analysis cases, and compile the 
analysis results. Many of the tools automate repetitive tasks that could take hundreds of hours if performed 
manually. Other tools are in place to check for errors or to signal you in case of inconsistencies. Application 
modules perform larger, more specialized tasks, often outside Patran. You use application modules to conduct 
the finite element analysis. Together the tools and applications help you carry out the simulation project. 
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Data Management
An important feature of the Patran infrastructure is the integrated database system. All of the information 
about your model and any analyses are stored here. This means you always have a complete history of your 
simulation project and a convenient means for partitioning the model into parts, comparing models, 
studying design changes, and evaluating compound effects of the environment.

A Link to Other Software
Another important attribute of Patran is its open architecture. With open data exchange you can share 
information with a variety of sources and software programs, including leading CAD systems, FEA codes, 
specialized modeling and graphics programs, and material and product knowledge databases. Using different 
software programs for different phases of the simulation process adds versatility. It also increases productivity 
since data and models created by one program can simply be brought into Patran with little or no time wasted 
in data conversion. 

Profile of a Simulation Project
A task road map helps you visualize the sequencing of tasks. Having a clear focus on the simulation tasks at 
hand will help you be more productive and efficient in learning Patran.

Simulation Tasks and Patran

Each of the three stages shown in the figure above represents a fundamental part of the simulation process. 
Within each stage is a set of tasks executed in different parts of Patran.
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Simulating a Product Design
This stage is typically the most time intensive. The simulation or model must describe the shape and size of 
the product, detail what materials are used to construct the product, stipulate how the product is assembled, 
and define the environmental forces that the product endures. The majority of the tools in Patran help you 
construct this product design model. 

Turning Product Designs into Geometry Models
Patran provides its own set of tools for geometry creation and editing. Using these tools, you can quickly 
create parts with two- and three-dimensional wireframe, surface, and solid geometry. The Geometry 
application form provides over a hundred options for creating basic geometric objects, as well as numerous 
editing and verification functions. Patran’s CAD interface also lets you import and edit CAD data from many 
leading CAD programs. 

Meshing and Creating Elements
Once you have imported or created the geometry, you can create and verify the finite element mesh using a 
powerful suite of meshing tools. These tools include the industry leading automeshers for curves, surfaces, 
and solids, as well as mapped meshing and paved surface meshing. Additionally, you can edit the analysis 
model interactively. 

Modeling Materials
The Materials application is where you define the materials for your analysis model. A material model is a 
group of material properties that describe what your model is made of (such as steel or a composite) and the 
attributes of that material (stiffness, density, and so on). Once you define the materials for your model, you 
will assign them to model regions.

Simulating Forces and Loads
The finite element analysis tests a particular model’s reaction to particular loads and constraints imposed as 
boundary conditions. Loads are environmental factors such as force, pressure, temperature, and voltage. 
Boundary conditions are described in terms of degrees-of-freedom, that are the directions in which the edges 
of the model are free to move in 3D space, along a translational (straight-line) or a rotational path.

Analyzing the Model with Environmental Loads
Once you have completed the product design model, the analysis stage of the simulation project begins.There 
are several options for running a finite element analysis using Patran. You may choose from one of MSC’s 
analysis codes, an outside commercial code, or an in-house proprietary code. In each case you will need to 
complete several tasks in Patran to format and setup the analysis.

Selecting an Analysis Code
You initially select an analysis code when you begin each simulation project. Patran assumes that you are using 
a single analysis code. As you build the product design model, Patran stores the information using the formats 
and naming conventions of the analysis code. At any time during the project you can change the analysis 
code. When you change the code selection Patran attempts to convert all of the data into the new format. 
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Tailoring the Model for a Selected Analysis Code
You will need to define element types (such as beam, shell, and so on) and element-related properties for 
regions of your model, then assign these definitions to geometric or FEM entities. Element type selection is 
based on the finite element code, the dimensions of the model, and your assumptions about the model’s 
behavior. Additional properties describe attributes such as the thickness of a plate, the spring constant for a 
spring, an area for a bar element, materials, and so on.

Running a Finite Element Analysis
The Analysis application provides the link between the Patran environment and the analysis solvers. These 
solvers can include MSC analysis codes, other commercially available solvers, or proprietary codes developed 
by analysts for their own exclusive use. The Analysis application provides the means to:

 Identify a desired analysis type.
 Define translation and solution parameters.
 Select a sequence of load cases.
 Select desired output.
 Send the model data to the analysis solver.
 Read results quantities from results files

Compiling the Analysis Results
Finite element results generated in the second stage of the project generally take the form of numbers, such 
as the amount of displacement at a point in the model. However, it is difficult to gain a real understanding 
of how a model behaves by looking at a stack of numbers on paper. The third stage of the simulation project 
entails using Patran’s ability to visualize results using computer graphics, animation, and other results tools.

Visualizing Numerical Results
Patran is state-of-the-art in its ability to display, sort, combine, scale, and query in a general way a single 
results database. After execution, analysis results are loaded directly into the Patran relational database and 
can be sorted by time step, frequency, temperature, or spatial location. 

The Sequence of Tasks
A standard simulation project carried out from start to finish would typically follow the sequence of tasks 
outlined above. However, it is important to point out that this task sequence is a generalization. In reality, 
each simulation project is unique with a distinct set of requirements, resources, data, and assumptions. These 
factors dictate both the tasks and the sequence. 

Within the simulation process there is an inherent feedback loop. Results or problems encountered in one 
stage of the project may prompt you to go back and change or re-examine a previous stage. Analysis results 
that exceed requirements often drive model design changes. 

Within each stage the sequence in which you perform the tasks may change. For example, you may choose 
to model the materials in your model once the geometry model is complete or you may elect to wait until 
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after the meshing is done. This depends on whether you plan to define the materials according geometrical 
regions or on an element-by-element basis.

As you learn to use Patran, keep in mind that the task sequences are flexible to a certain degree. For each 
project that you begin, you will have to evaluate the requirements, resources, and data, to develop a 
task plan. 

A Case Study of an Annular Plate
This example illustrates the use of Patran when there is a component having 3D geometry that is to be 
represented by 2D analysis geometry. In this example an annular plate is created in Patran, analyzed in MSC 
Nastran and postprocessed in Patran. A linear static analysis will be performed on the annular plate. Our 
analysis objective is to determine its maximum stress and deflection.

Problem Description
The annular plate has a concentric central hole, is simply supported at outer boundary and is subject to an 
annular line load as shown in Figure 1-1. The associated geometric, load, and material properties are described 
by Table 1-1.

Figure 1-1  Representation of the Annular Plate

Table 1-1  Dimensions and Properties of the Annular Plate

Outer Radius, a = 20 inch

inner Radius, b = 5 inch

Annular Line Load Radius, r = 10 inch

Line Load, W = 1.2 lb/in

Elastic Modulus, E = 10E6 psi

Poisson’s Ratio, ν = 0.3

Thickness, t = 0.125 inch
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Conceptual Model
Physically, the plate is a solid and could be modeled using solid finite elements that approximate the solution 
of three dimensional theory of elasticity. Conceptually, we could create a model having hundreds to 
thousands of elements to capture a close approximation to the exact solution. If we were to perform this 
analysis and critically review the results, we would find that the displacement varies linearly through the 
thickness and that the components of stress in the thickness direction are very small compared with the stress 
components in the in-plane directions.

Fortunately, S. Timoshenko and others have already made these discoveries and have employed appropriate 
assumptions to simplify the three dimensional theory of elasticity to a two dimensional membrane solution 
for in-plane behavior and a two dimensional strength of materials approximation, called Plate Theory, for the 
out-of-plane bending behavior.

The use of a plate representation rather than solid elements raises the question: why not use solids elements 
in this example? After all, with the power of Patran and MSC Nastran to create and solve large models, why 
bother with an approximation?

The ultimate answer is resources. With plate representation, we can obtain a solution which is sufficiently 
accurate for design verification using significantly fewer resources. And, with the need for rapid response to 
design requests for simulation, it is vitally important to minimize problem size. 

Figure 1-2  Patran Finite Element model of Annular Plate 

Theoretical Solution
The theoretical solution for this case is shown below. The maximum stress at the inner edge is:

where  and W is the total applied load.

σb
3W

2πmt2
----------------— 2a m 1+( )

a2 b2—
--------------------------- a

b
---log m 1—( )+=
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The maximum displacement is:

Case Study Task Outline
At this point we have defined the problem and conceptually established how we will model the annular plate 
for analysis. Next we need to map out individual modeling and analysis tasks, set up the sequence for the 
tasks, and specify key parameters.

To set up the framework for the project we begin with a simple checklist. In the list below, the left side 
identifies the parameters or tasks that are critical to the project. The right side shows the specifics that we have 
decided on for the analysis. These specifics will drive the project and sequence of tasks. 
 

From the checklist we have generated a Task Map that will serve as the guide for the project.

 Analysis Objective Deflection/von Mises stress from load (linear-static.)

 Model database Annular Plate

 Analysis Code/Type MSC Nastran - Structural

 Solution Type Linear Static

 Geometry Created in Patran

 Mesh Creation IsoMesh - Quad 4 elements 

 Loads and Boundary Conditions 
(LBC)

Pinned Support - Line Load

 Material Properties Isotropic/Aluminum/Linear Elastic

 Element Specification 2D/Shell/Aluminum

 Analysis Linear static

 Results Results file/deformation plot/stress fringe plot

max
3W m2

1—( )
4πEm2 t3

--------------------------------— a2 b2—( ) 3m 1+( )
m 1+( )

------------------------------------------------
4a2b2 m 1+( )
m 1—( ) a2 b2—( )
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Figure 1-3  Case Study Task Map
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Analysis Procedure

Setup the Analysis Project 

Creating a New Database
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 On the Patran Main Menu, select File /New. The New Database Form appears.
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 Enter the name annular_plate in the Filename textbox.
 Click OK. 
 The New Model Preferences form appears. This form allows you to specify the generic analysis 

parameters for the model.

Selecting Analysis Parameters

 Set the Tolerance to Default.
 Choose MSC Nastran from the Analysis Code pull-down menu.
 Choose Structural from the Analysis Type pull-down menu and click OK.
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Build the Geometry 

 Creating the Base of the Annular Plate

 On the Patran Main Menu, click on the Geometry Application button.
 On the top of the Geometry form, select Action>> Create, Object>>Curve, and Method>>XYZ.
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 Enter a Vector Coordinate List of <5,0,0> and Origin Coordinate List of [5,0,0]. Click Apply.
This creates a line 5 inches long in the X-direction starting from position [5,0,0]. 

 Change the Vector Coordinate List to <10,0,0> and the Origin Coordinate List to [10,0,0]. Click 
Apply. This creates Curve 2 that represents the radius of the outer ring.

 Create the Surfaces of the Annular Plate
 On the top of the Geometry form, change the Object selection from Curve to Surface, and set 

Method to Revolve.
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 Under Sweep Parameters, enter a Total Angle of 90.0 and an Offset Angle of 0.0. Click on Curve 1 
that was previously created (or type curve 1 in Curve List text box). Click Apply. 

 To create Surface 2, type Curve 2 into the Curve List textbox and click Apply. 
 Repeat the same procedures for Surface 1.2, 2.2, 3.2, 4.2, 6.2 and 5.2. For instance, type Surface 1.2 

in the Curve List textbox and then click Apply. 

Create the Finite Elements 



17Chapter 1: Introduction
A Case Study of an Annular Plate
 Create a Surface Mesh with Quad 4 Elements

 On the Patran Main Menu, click on the Elements Application button.
 On the top of Finite Element form, select Action>>Create, Object >> Mesh, Type >> Surface. Use 

this combination to create a surface mesh.
 Set the Value of Global Edge Length to 2. This will determine the size of our plate elements. Then, 

cancel the Automatic Calculation selection.
 Choose Quad4 from the Topology pull-down menu. This selects the type of element that will be 

used to mesh the surface geometry. The IsoMesh mesher is automatically selected below.
 Place the cursor in the Surface List textbox and then cursor select all the surfaces on the screen (or 

type in Surface 1:8, and click Apply). 
 Because the finite elements are not connected along the geometric boundaries, we need to “sew” 

them together.

Equivalencing the Mesh
 On the top of the Finite Element form, select Action >> Equivalence, Object >> All, Method >> 

Tolerance Cube. This will equivalence the nodes along all surface boundaries. 
 Click Apply.
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Model the Materials 

Create a Material

 On the Patran Main Menu, click on the Materials Application button.
 On the top of the Materials form, select Action >> Create, Object >> Isotropic, Method >> Manual 

Input. 
 In the Material Name textbox, enter “Aluminum.”
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 Click on the Input Properties button.
 Specify the Material Properties of Aluminum
 On the Input Options form, enter 10e6 in the Elastic Modulus databox.
 In the Poisson’s Ratio databox, enter 0.3.
 Click OK to close the Input Option form, and then click Apply on the Materials form.

Define Element Properties 

Create a Property



Patran User’s Guide
A Case Study of an Annular Plate

20
 On the Patran Main Menu, click on the Properties Application button.
 On the top of the Element Properties form, select Action >> Create, Object >> 2D, Type >> Shell. 
 In the Property Set Name textbox, enter prop_1.
 Click on the Input Properties button.
 On the Input Properties form, click in the Material Name textbox and select Aluminum from the 

Material Property Set list.
 Enter a shell thickness of 0.125 inch, and click OK. 
 On the Element Properties form, place the cursor in the Select Members databox and then cursor 

select all the surfaces on the screen (or type Surface 1:8).
 Click Add and then Apply on the Properties form.

Simulate the Loads and Boundary Conditions (LBC) 

Create a Distributed Load

 On the Patran Main Menu, click on the Loads/BCs Application button.
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 On the top of the Loads/BCs form, select Action >> Create, Object >> Distributed Load, Type >> 
Element Uniform. 

 In the New Set Name textbox, enter annular_load.
 Click on the Input Data button.
 On the Input Data form, enter < , ,-1.2> for Edge Distr Load and leave the Edge Distr Moment 

field blank. Click OK.
 Click on the Select Application Region button.
 On the Select Application Region form, under Geometry Filter, click on Geometry.
 Place the cursor in the Select Surface Edges listbox. Use the cursor to select the 4 middle surface 

edges from the screen. Click Add after each selection, then click OK.
Surface 7.1 1:5:2.3 should appear in the Application Region listbox.

 Click Apply on the Loads/Boundary Conditions form.
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Create a Constraining Condition (Displacement)

 On the Patran Main Menu, click on the Loads/BCs Application button.
 On the top of the Materials form, select Action >> Create, Object >> Displacement, Type >> Nodal.
 In the New Set Name textbox, enter pinned.
 Click on the Input Data button.
 On the Input Data form, enter <0,0,0> for Translations and leave the Rotations field blank. 

Click OK.
 Click on the Select Application Region button.
 Under Geometry Filter, click on Geometry.
 In the Select menu, click on the Edge option.
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 Place the cursor in the Select Geometric Entities databox. Use the cursor to select the 4 outer surface 
edges on the screen. Click Add after each selection, then click OK. Surface 2:6:2.3 7.3 should be the 
edges selected.

 Click Apply on the Loads/Boundary Conditions form.
 Rotate to Iso3 view.

Create MSC Nastran Input File 

Create the MSC Nastran Input (Bulk Data) File and Run the Analysis

 On the Patran Main Menu, click on the Analysis Application button.
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 On the top of the Analysis form, select Action >> Analyze, Object >> Entire Model, Method >> Full 
Run.

 Click on the Solution Type button.
 On the Solution Type form, select Linear Static. Click OK.
 Click Apply on the Analysis form.
 The analysis will take a few seconds before finishing depending on the speed of your computer. A 

file by the name annular_plate.bdf is created and submitted to MSC Nastran. This assumes 
proper configuration of the P3_TRANS.INI file (Windows) or the site_setup file (Unix), which 
point Patran to the proper location of the MSC Nastran executable.
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Retrieve the Analysis Results 

Translate the Results into Patran for Results Postprocessing

 On the top of the Analysis form, select Action >> Access Results Object >> Attach XDB, Method 
>>Result Entities. 

 Click on the Select Results File button.
 On the Select File form, select annular_plate.xdb. Click OK.
 Click Apply on the Analysis form.
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Results Postprocessing 

Create Fringe and Deformation Plot
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 On the Patran Main Menu, click on the Results Application button.
 On the top of the Result form, select Action >> Create, Object >> Quick Plot. 
 In the Select Result Cases window, select Default, Static Subcase.
 In the Select Fringe Result window, select Displacement, Translational.
 In the Select Deformation Result window, select Displacement, Translational.
 Click Apply.
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Starting and Exiting Patran

Patran (Windows):

 Start up Patran by choosing 

Start/Programs/MSC.Software/Patran 20xx. 

or

Double-click on the Patran 200x icon on the desktop if installed using this option.

Patran (Linux):

 Type patran and press <Return> at the operating prompt from any Linux shell window. This 
assumes that the command patran is in the user’s path.

If you do not see the Patran window or if Patran does not start correctly after entering the start-up command, 
report the error to your system administrator or access your Patran Installation and Operations Guide. (You 
can access the Installation and Operations Guide on the Web at www.mscsoftware.com, under Support, 
Training, and Documentation.) 
The Installation and Operations Guide contains step-by-step directions for tracking down start-up problems 
and provides a working solution.

To quit, from the Patran File menu, select Quit. Patran automatically saves any changes that you made to the 
current database when you exit.

A Tour of the Patran Interface
At the center of the Patran window is a blank graphics viewport where you construct your finite element 
analysis model. The menu bar, toolbar, and application buttons shown below are your control panel. The 
history area keeps you informed on what Patran is doing, and reports on what has occurred. The command 
line is used to enter customized commands and the application forms are used to build each part of your 
model. 

The Command Window, RHS Window, Model Browser and Classic Menu Bar are dockable entities. These 
can be opened or closed by right clicking on the empty space of ribbon bar and then selecting the object(s) 
to open or close. 



31Chapter 2: Fundamentals
A Tour of the Patran Interface
Toolbar Icons
A group of shortcuts for 
frequently used Patran 
functions.

Menu Bar and Ribbon
Displays the forms needed to 
build your model, run the 
analysis, and process the 
results.

Controls system tasks such as 
managing files, selecting analysis 
codes, and manipulating graphics 
and displays.

 Menu 

Command Output
Contains a record of all 
commands executed during an 
Patran session.

Application Forms
Displays different application 
forms for inputting data.

Command Line
Enables you to enter PCL 
commands from the keyboard for 
customization.
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How to Get Things Done

This section contains basic information on using the different components in the Patran to complete tasks. 

 Working with viewports
 Menubar
 Application buttons and forms
 System and Toolbar icons
 Command and history areas
 Picking and selecting

This information is intended to get you started using Patran. More detailed information can be found in the 
Patran Reference Manual.

Working with Viewports
A viewport is a graphics window in which the entire model (or a selected portion of a model) appears. A blank 
viewport, similar to the one shown below, appears at the center of the Patran window when you create a new 
Patran database.

The top of the viewport lists the name of your database (in this case test.db), the name of the viewport 
(default_viewport), the name of the current group (default_group), and the mode of operation for displaying 
the model (Entity). The Global Axes show the orientation of your model. A plus sign (+) marker indicates 
the global origin.

To move and resize viewports within the Patran window:

1. Move the cursor over the Viewport title bar.

2. Click and drag the viewport to a new location.
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3. Window machines allow for double clicking to fit the graphics window.

or

1. Move the cursor to any of the outside boarders or corners of the viewport.

2. When a two-headed arrow appears, click and drag the viewport to the desired size.

With Patran, there is no limit to the number of viewports you can create. Multiple viewports enable you to 
see different views of the model, different parts of the model, and different analysis results.

To create multiple viewports:

1. Select Viewport/Create from the top menu bar.

The Viewport Create application form appears in the Patran window.

2. Enter a name for the new viewport in the New Viewport Name textbox, and click Apply.

Your original viewport is the default viewport, and each subsequent viewport that you create appears 
in the Existing Viewports listbox.

The Menu Bar

The Menu Bar is located directly under the Patran title bar. Each menu keyword has a drop-down menu with 
additional commands. The menu keywords are shown below. 

File
When you invoke Patran, only the File menu is enabled; the other menus become enabled once you open a 
database. The File menu provides access to the various files used by Patran, including database file 
management, file importing and exporting, session file handling, hardcopy file creation, the status database, 
and session exiting.
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Group
The Group menu contains various options for you to organize into groups the geometric entities (points, 
curves, surfaces, solids) and finite element entities (nodes, elements, multipoint constraints) of a Patran 
model. You can then perform numerous modeling and postprocessing tasks on these groups. 
For example, you could group finite elements composed of different materials. Or, for viewing results, you 
could create separate groups for displaying temperature and stress distribution on the same model 
simultaneously.

Viewport
Viewports are movable, sizable graphics windows used to display all or part of a model. Each viewport 
provides one independent view of a stationary model, and maintains a set of parameters to determine how 
you want to view it. 

Use the Viewport menu to create, edit, remove, and arrange your different viewports.

To move, resize, or create new viewports, see Working with Viewports.

Viewing
The Viewing menu contains various options to control the size and orientation of a model within a viewport. 
You can manipulate a model’s rotational orientation, size, position, type of projection, scale factors, and 
clipping planes. You can also control your viewport’s viewing plane, observer position, window center, and 
focal point.

Changing your view in no way alters the model. With the Viewing menu options, you can pan, zoom in and 
out of, rotate, and resize your model. 

Viewing Size and Positions on the Toolbar
For quick changes in viewing orientation, select from the set of viewing icons on the toolbar. For additional 
information on the toolbar, see Viewing Functions.

Also note that as you construct your model, Patran automatically resizes the viewport each time you add an 
entity outside the current field of view. The viewport is adjusted to encompass all entities in your current 
group. 

More About Viewing Rotation 
There are two ways to view the rotation of your model: around the model’s global axes or around your screen’s 
axes. You can view each of these in absolute or relative terms, as shown in the table below:

 

Model Absolute Rotation is about the global axes, starting from the axes’ zero rotation point.

Model Relative Rotation is about the global axes, starting from the axes’ current location.

Screen Absolute Rotation is about the screen axes, starting from the axes’ zero rotation point.

Screen Relative Rotation is about the screen axes, starting from the axes’ current location.
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Display
Databases can get large and full of geometric and finite element entities. The Display menu helps you 
organize and enhance the appearance of these entities. With the Display menu, you can determine which 
entities you want displayed and how you want them displayed. And you can control numerous visualization 
features, such as render style, entity plotting and erasing, highlighting, and label display. 

The Display features do not affect the basic operations of Patran. They merely enhance the usability and 
appearance of your models. 

Preferences
With the Preferences menu, you can choose what parameters you want to govern the construction and 
appearance of your model.

The Preferences menu defines global parameters that you can override in specific applications. For example, 
during an equivalence operation, you can override the global model tolerance (the default equivalencing 
tolerance). Patran, however, will not use the new tolerance value in subsequent operations outside the given 
application. 

The only way to change a preference permanently is to set it within a Preferences form. 

Tools 
The Tools menu executes the optional applications licensed at your site without exiting Patran. It also 
provides a path to some of Patran’s newer, add-on features that you purchased at an additional cost. If an 
application module is not licensed, the option for it on the Tools menu will be dimmed, indicating that it is 
unselectable.

Using Lists
You can create numerous types of lists using the List option, including the following: 

 You can, for example, build a list of entities having all nodes that equal zero. 
 You can also combine lists to create other lists; for example all nodes equal to a certain value, and all 

elements associated with that value. 
 You can use List to perform Boolean operations. 

Help
Use the Help menu to retrieve detailed online documentation for all of Patran’s features and tools. Through 
the Help menu you can also access tips on keyboard shortcuts, mouse functions, and screen picking. 



Patran User’s Guide
How to Get Things Done

36
Application Buttons and Application Forms

There are a number of application buttons in the Patran window that relate to specific tasks in Patran. For a 
standard FEA analysis, the radio buttons are arranged so that you can progress from left to right in the course 
of your MSC.Patarn session. However, you can access most buttons at any time, once you have created a 
database. 

Brief descriptions follow for all the Patran application buttons. 

Application Function

Geometry Creates and edits geometric models.

FEM (Elements) Selects finite element shapes and creates a finite element mesh.

LoadsBCs (LBCs) Assigns loads and boundary conditions.

Materials Defines the material properties of the model. 

Properties Assigns element properties to model entities.

Load Cases Defines load cases for your model.

Fields Defines variation in properties and materials.

Analysis Sets analysis parameters, submits the job, and reads result files.

Results Defines how the results from the analysis display and plot. 

XY Plot Defines XY plots of results.
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Application Forms
Selecting an application button displays an application form. Application forms are the primary method to 
define your model and control the analysis. Many application forms have subordinate forms, such as the 
Materials form and its subordinate Input Options form shown below.

You can choose only one application radio button at a time. Once you pick a second application from the 
window, the second application form appears and the first form closes. While you can only have one 
application form open at a time, you can have other forms open from the menubar. The tabs located at the 
bottom of the forms allow you to toggle between the forms that you have open. You can close an application 
by clicking its radio button.

This is the Material Application form. The Action, Object 
and Method are common to most Application forms.

The Subordinate form appears when the Input Properties... 
button is pressed on the Materials Application form.
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Filter

A filter is used in applications where a list of selectable components may be longer than the number of items 
that can be displayed in a listbox. With the filter you can isolate a single item or a group of several items that 
comprise a subset of the list. For example, you may have defined a number of load cases, one of them named 
Heavy. To access this load case (for example, to modify it), you don’t need to scroll through a long list to find 
its name in the listbox, instead, type heavy (entries are not case sensitive), press the Filter button, and this 
load case will be selected. 

You can use the following wildcard symbols:

* (any character string) 

? (a single character) 

If, in the above example three of the load cases are named Heavy100, heavy300, and heavy500, you can enter 
h* and now the displayed list will be the subset that consists of the load cases whose name begins with the 
letter h. 

Filter ON/OFF: A new Filter ON/OFF toggle button has been added above the existing list filter to some 
forms in the following sections:

 Group
 Load Cases
 Analysis -> Subcases
 Loads/BCs
 Materials
 Properties. 

It switches the filter ON or OFF to change between a filtered list and the complete list. 

Particularly, in the large models where the listbox contains several items and you need to switch between the 
filtered list and complete list, the Filter ON/OFF toggle makes the task easier. 

By default, the filter is ON.

The Toolbar
The toolbar is a set of often-used functions displayed as a row of icons. These functions are grouped into 
several sets and used for model view control, render styles, predefined view orientations, and other functions. 
It is customizable, so you can add your own functions and icons or remove them.
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You can rearrange the icons on the toolbar. Simply click and drag a set of icons to another area on the toolbar 
or to another location in the Patran window.

System Functions
The nine icons shown below are the system icons. At start up only two icons are active: the File New and File 
Open. Once a database is opened, the remaining icons become active.

Icon Name Icon Function

File New Brings up the New Database form. 

File Open Brings up the Open Database form where you can select an 
existing database to open.

File Save Updates any changes made to your database.

Print Prints the contents of a viewport or the XY window. You can 
print a single viewport or window, or you may print multiple 
viewports or windows.

Copy to Clipboard Not Available Copies the contents of the current viewport to the clipboard.

Undo -Apply- or -OK- buttons perform actions that add, delete, or 
modify entities in the database. To Undo the last operation 
invoked by -Apply- or -OK-, press the icon that depicts a 
reversal arrow. The graphics will refresh, all entities that were 
deleted as a result of the last apply are redisplayed, any entity 
that was added is erased, and any entity that was modified is 
returned to its previous state.
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Mouse Functions
Using the toolbar icons below, you can customize the middle mouse button to change to view of your model. 

Abort There may be times during a session when you would like to 
abort a time consuming operation. This can be accomplished 
by depressing the icon depicting a raised hand. If the heartbeat 
is Blue when depressing the icon, Patran responds by presenting 
a form asking, “Do you want to abandon the operation in 
progress?” This question requires a yes or no response. 

Reset Graphics Removes all fringe and marker plots, all automatic titles, 
highlighting, and deformed shape plots. Repaints the viewport 
in wireframe mode. This button works on all posted viewports 
in entity mode, but only on the groups posted in the current 
viewport in group mode.

Refresh Graphics Refreshes all of the graphics viewports.

Default Window 
Layering

Linux only. Brings the Main form to the front of the display 
screen and layers other menus and viewports. This is especially 
useful when the Main form has obscured the viewport or other 
menus. 

MSC Information Linux only. On Windows use Help/About Patran. This includes 
the Patran release number, your customer name and ID 
number, the X server and X Client information, trademarks, 
copyright information, and access to the license status program. 

Icon Name Icon Function
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Viewing Functions
The Viewing menu located on the top menubar contains several options for controlling the view of your 
model in the viewport. A subset of these options are quickly accessible from two sets of viewing icons located 
on the toolbar.

Icon Name  Icon Function

Mouse Rotate XY Sets the middle mouse button to control model rotation 
about the X and Y axes.

Mouse Rotate Z Sets middle mouse button to control model rotation 
about the Z axis.

Mouse Translate XY Sets middle mouse button to control model translation in 
the X and Y directions.

Mouse Zoom Sets middle mouse button to control zoom in and out of 
the model.

Icon Name  Icon Function

View Corners  Zooms in on a cursor-defined rectangular area in viewport.

Fit View Resizes the current view so that all entities display in the current 
viewport.
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The next set of viewing icons define the orientation of the model in the viewport. By clicking one of the icons 
below, you can quickly view your model from different angles. The default orientation is a front view. 

View Center Pans the model by moving the current viewport center to a 
cursor-picked location.

Rotation Center Allows selection of the model’s rotation center by choosing a 
point, node, or screen position.

Model Center Sets the rotation center to the centroid of the displayed entities.

Zoom Out Incrementally zooms out from the model by a factor of two.

Zoom In Incrementally zooms in on the model by a factor of two.

Icon Name  Icon Function

Front X = 0, Y = 0, Z = 0

Rear X = -180, Y = 0, Z = -180

Icon Name  Icon Function
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Display Functions
The two sets of Display icons located on the toolbar provide quick changes to the way in which you display 
your model in the viewport.

Top X = 90, Y = 0, Z = 0

Bottom X = -90, Y = 0, Z = 0

Left Side X = 0, Y = 90, Z = 0

Right Side X = 0, Y = -90, Z = 0

Iso1 X = 23, Y = -34, Z = 0

Iso2 X = 23, Y = 56, Z = 0 

Iso3 X = -67, Y = 0, Z = -34

Iso4 X = -157, Y = 34, Z= 180

Icon Name  Icon Function



Patran User’s Guide
How to Get Things Done

44
Icon Name  Icon Function

Wire Frame Displays model in wireframe render style.

Hidden Line Displays model in hidden line render style.

Smooth Shaded Displays model in smooth shaded render style.

Element Shrink Toggles the display of Element Shrink between 
ON and OFF.

Cycle Background Changes the viewport background color.

Cycle Show Labels Toggles the display of Entity Lables between ON 
and OFF. 

MPC Markers 
On/Off 

Toggles the display of MPC Markers between ON 
and OFF.
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Point (0D) Element 
Marker On/Off 

Toggles the display of Point (0D) Element Marker 
between ON and OFF.

Connector Element 
Markers On/Off

Toggles the display of Connector Element Markers 
(both 2D and 3D) between ON and OFF.

Icon Name  Icon Function

Plot/Erase Displays Plot/Erase form.

Label Control Displays a form for controlling label display for selected 
entities.

Point Size Toggles point display size between one and nine pixels.

Node Size Toggles node display size between one and nine pixels.

Display Lines Toggles the geometry visualization lines between zero and 
two.

Icon Name  Icon Function
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Home (Windows only)

Click on the Home icon to bring up MSC Software’s Web page using your default browser. 

Heartbeat

The Heartbeat icon indicates whether Patran is busy or waiting for input from you. Gray icon means ready 
and waiting. The blue icon means busy, but can be interrupted. The red icon means busy, cannot be 
interrupted. 

Command Line and History List Area
The Command Line and History List Area appear at the bottom of the Patran window. You can manually 
enter commands in the command line. The history list area is used to view the commands that Patran 
generates when a menu form is executed, and to view errors or informative messages. You can resize the 
History window in order to see more lines in the History List Area. 

Picking and Selecting 
Many times when you are working with application forms, a menu of icons appears to the left of your form. 
From this Select menu you can choose objects directly off the screen rather than typing in data on the 
application form. By selecting one of the Picking Filters from the Select menu, you control what type of 
objects you pick off the screen and how you select the object.

Picking and selecting off the screen can be a complex task. This section covers basic information about several 
aspects of the Select menu.

 Types of Select menus.
 Different levels within Select menus.
 Menu appearance.
 How to pick entities from the screen.
 Picking operations.
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Select Menus

There are over 25 different Select menus in Patran. The Select menu that appears on your screen depends on 
the application in which you are working. For example, if you are creating a new point in your geometry 
model, the Point Select menu appears. Alternatively, if you want to select a finite element from a mesh that 
you have already generated, you will see the Element Select menu on your screen.

Each Select menu displays a series of graphic icons. As you move the cursor over each icon, the filter name 
appears next to the icon. The first four icons are common to all Select menus and control overall picking and 
navigating functions. The remaining icons are specific to each Select menu and act as 
picking filters

An example of the Point Select menu is shown below.

 

Icon Function

Toggle Visible Entities Only Selection Selects either visible objects only, or visible and hidden 
objects.

Polygon Pick Selects all objects that lie within a polygon area.

Pick Clear Clears the selected/picked entities and updates 
Viewport(s) only.

Pick All Selects all entities based on the current Picking Filter set 
to and updates Viewport(s) as well as the current select 
databox.

Go to Root Menu Reverts back to the original Select menu.

Go to Previous Menu Reverts back to the previous Select menu.

Any Point Selects a point associated with any geometric or finite 
element object.

Point Selects a point.

Node Selects a node.

Curve Intersect Selects the point at which two curves intersect.

Point on Curve Selects a point on a curve closest to a point off the 
curve.

Any Vertex Selects the vertex of a curve, surface, or solid.

Entity filter icons

Visible entity ON/OFF toggle

Polygon pick Picking Icons

Go-to icons
Clear / Select All
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Multilevel Select Menus
Some of the Picking Filter icons you select will display a second and perhaps a third level Select menu. Each 
lower level menu in the hierarchy automatically replaces the previous Select menu. Only one Picking Filter 
menu is active at a time. As you continue to make filtering selections you further define how you will pick 
the object off the screen. 

To navigate through different levels of menus in the hierarchy, use the two icons near the top of each Select 
menu:

Appearance of the Select Menu
By default, the Select menu appears as a set of icons arranged vertically and docked in the application form 
area. Like Patran’s toolbar, you can undock and reposition the Select menu as a free floating menu at any time. 
You can also dock the Select menu on the left side of the window, in the toolbar area, or at the bottom of the 
window. Any changes that you make to the appearance or location of the Select menu remains in effect each 
time you open a database.

To change the appearance of the Select Menu:

1. Move the cursor over the title bar area of the Select menu.

2. Click and drag the menu to a new location.

The Select menu can appear as a free floating menu anywhere in the viewport.

or (on Windows)

1. To maintain a vertical set of icons, click and drag the Select menu to the left side of the Patran window 
and release. 

2. To switch to a horizontal set of icons, click and drag the Select menu to the toolbar area or to the 
History/Command Line area.

Pierce Selects the point where a curve and a surface intersect.

Point on Surface Selects a location on a surface.

Screen Position Selects a X-Y screen position.

Click on the Go to Previous Menu icon to return to the previous Select menu

or

Click on the Go to Root Menu icon to return to the original Select menu

Icon Function
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Picking an Entity off the Screen
There are two basic methods of picking entities off the screen: enclosing an entity by drawing a boundary 
around it, or pointing directly at the object, and selecting it.

Enclosing Entities
You can use the enclose function to select any number of objects off the screen at one time. This is especially 
useful when you want to select a large number of objects that you would otherwise have to select one by one. 

On the Select menu there are two types of boundaries that you can use to enclose objects: a rectangular 
boundary and a polygon boundary. The rectangular boundary is the default. The polygon boundary offers 
more flexibility in defining the shape of the boundary.

To use the Polygon boundary:

1. Click on the Polygon icon located on the Select menu (on Linux this icon is in the main 

toolbar).

2. First move the cursor into the application form databox and click.

3. Next move the cursor into the viewport. Click once to define the first vertice of the polygon.

From there you can move and click the cursor as many times as is necessary to define your polygon.

To use the rectangular boundary:

1. Click in the application form databox and then move the cursor into the viewport.

2. Click and drag the cursor arrow to define an enclosing rectangle.

What happens when an object lies partially within and partially outside the boundary you drew? 
This depends on your picking preferences. Using the Preferences/Picking menu from the menu bar, 
you can specify that the object needs to be entirely enclosed, partially enclosed, or only the centroid 
need be enclosed. This preference then instructs Patran whether to include or exclude an object lying on the 
boundary.

Selecting Individual Entities
On each Select menu there are typically several icons that control how you pick individual objects off the 
screen. These features are most useful when you are selecting one or two objects, or when the desired objects 
are located such that you can’t enclose them using a boundary.

The filtering icons are specific to the application. The default picking icon is the Any icon. Using 

this function you can select any object off the screen that corresponds to the current application. This is 
essentially the unfiltered picking function.

To select an object:

1. Click in the application form databox and then move the cursor into the viewport.

2. Point the cursor arrow at the desired object and click.
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or, to be more selective in your picking:

1. Select one of the picking filter icons on the Select menu.

2. Click in the application form databox and then move the cursor into the viewport. Point the cursor 
at the desired object and click.

Clearing Selected Entities
This function enables you to deselect the selected entities and refresh the viewport.

To deselect the selected objects:

 Click on the Pick Clear icon on the Select menu. All picked entities get deselected and the viewport 
gets updated.

Selecting All Entities
You can use the Pick All function to select all entities of a particular type based on the current picking filter. 

To select all entities:

 Set the filter and click on the Pick All icon. All entities that qualify your current picking filter 
criteria, get selected. For Example:

• If filter is set to "Any entity" then "Pick All" selects all entities (Geometry and FEM).

• If filter is set to "Any Geometric entity" then "Pick All" selects all Geometric entities.

• If filter is set to "Any FEM entity" then "Pick All" selects all FEM entities 

• If filter is set to "Any element" then "Pick All" selects all elements only. 

• If filter is set to "Point" then "Pick All" selects all points.

• If filter is set to "Node" then "Pick All" selects all nodes.

• etc.

Changing the Picking Operation
Using the Select menu you can add an entity to an application form, replace an existing entity on the form, 
or remove an already selected entity form a form. When the Select menu first appears, it is in Replace mode. 
Any entity that you select from the screen replaces an existing entity if one is designated in the databox. 

To change this mode to add or remove entities:

1. From the Patran menu bar, select Preferences/Picking.

The Picking Preferences menu appears in the Application form area.
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2. Click on the Show Picking Icons checkbox.

This instructs Patran to add a set of Picking Operation icons to your Select menu. You will see a 
message box informing you that you need to restart Patran in order for this change to take place.

3. Quit and restart Patran.

4. Resume the Application that brings up your Select menu.

You should now see the three additional picking operation icons. These icons remain on each Select 
menu until you change the Picking Preferences form again.
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5. Click on one of the other Picking Operation icons to change the Picking mode.

This operation changes a setting in a file called settings.pcl, generally located in the installation directory. If 
this operaiton does not work it is usually because there are no permissions set to change this file. You may 
need to either change the permissions or copy the file to the directory from which you are running and do 
the operation again. 

Picking objects from the viewport can be a difficult task. The features discussed in this section are the basic 
features of picking and selecting. For more information about individual picking icons, select menus, and 
picking off the screen, please refer to the Patran Reference Manual, Volume 1, Part I Introduction to Patran, 
Chapter 3: Interactive Screen Picking.



Chapter 3: The Database
MSC Nastran Implicit Nonlinear (SOL 600) User’s GuidePatran User’s Guide

3 The Database

 Creating a Database     54

 Specifying Model Parameters     55

 Importing CAD Models     56



Patran User’s Guide
Creating a Database

54
Creating a Database
After starting Patran, you need to either create a new database or open an existing one. If a project database 
already exists, open the database by selecting File/Open from the Main menu and double-click on the name 
of the database. If a database does not exist, create a new database as follows.

To create a new database:

1. Select File/New from the Main menu.

Selecting File/New displays the New Database form shown below.

2. Specify the filename for the new Patran database.

If you try to specify a database name that already exists, you will be asked if you want to overwrite the 
existing database and create a new one.

3. Select the directory in which the database will reside (located at the bottom of the form). 

After clicking OK, you should see a viewport window appear on your screen.
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Specifying Model Parameters
It is important to select the Analysis Code, Analysis Type, and Global Model Tolerance before you begin 
building your analysis model. Your choices for Analysis Code and Type affect code-specific forms as well as 
the options available for element types, element properties, and material definitions. Your choice for the 
Global Model Tolerance impacts how you construct your model. You may specify these three items using the 
New Model Preferences form. 

Global Model Tolerance Definition
The Global Model Tolerance sets a minimum distance between separate points, curves, surfaces, and solids. 
If you try to create two entities, such as points within the global model tolerance distance from each other, 
Patran sees these two entities as one and you will not be able to create the second. This setting ensures that 
your geometric model will mesh properly and maintain congruency

To set the Global Model Tolerance:

1. On the New Model Preferences form, choose which method you will use to define the Global Model 
Tolerance value.

Choosing Default assigns a default value to the Global Model Tolerance. This value is initially set at 
.005 inches. (You can change the default value by selecting Preferences/Global on the Main menu). 
If you select Based on Model, the Tolerance value is defined as .05% of the Maximum model 
dimension.

Analysis Code and Analysis Type
The New Model Preferences form automatically appears when you complete the New Database form. (If you 
do not see this form on your screen, check on the New Database form to make sure that the Modify 
Preferences toggle button set to ON.

To specify the analysis code and analysis type:

1. Select one of the analysis codes from the Analysis Code drop-down menu. 

You should see a list of the analysis codes available at your site.

2. Use the Analysis Type drop-down menu to assign the type of analysis.

You can select a Structural, Thermal, Implicit Nonlinear, Explicit Nonlinear, Aeroelasticity, or 
Coupled analysis. This selection needs to match the capabilities of the analysis code you selected.
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Importing CAD Models 
In many cases, it is much more efficient to use an existing CAD geometric model created outside of Patran 
rather than constructing a new model. Importing CAD models may avoid repetitive modeling efforts and 
ensure better accuracy between a CAD design model and its analysis model. Patran supports direct interfaces 
to all major CAD systems. 

 Unigraphics 
 PRO/Engineer
 CATIA

Global Model Tolerance Two points in the model will be coincident if they are separated by 
a distance equal to or less than the Global Model Tolerance.There 
are two options for setting the tolerance.

Based on Model Calculates the tolerance as.05% of the Approximate Maximum 
Model Dimension.

Default Uses the setting defined in the template database, normally.005.

Analysis Code Select the Analysis Code from the options installed at your site.

Analysis Type The Analysis Type depends on the Analysis Code you select. It can 
be Structural, Thermal, Implicit Nonlinear, Explicit Nonlinear, 
Aeroelasticity, or Coupled.
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 ACIS
 IGES and other CAD file formats

Many other third-party modeling packages can be supported via the use of the ANSI industry standard IGES 
(Initial Graphics Exchange Standard) protocol.

To import a CAD model:

1. Select File/Import from the Patran Main menu.

Selecting File/Import displays an Import form that you use to import a CAD geometric model or a 
Patran database.

2. On the Object drop-down menu, select Model.

The Object can be either a Model or Results.

3. Specify a Source from the Source drop-down menu.

The Source can be one of several CAD packages or intermediate files that hold exported models.

4. Click Apply.

Patran provides two types of CAD access: CAD Import and CAD Interface. CAD Import allows import of 
a limited set of CAD geometry types (IGES, STEP, ProE .geo, CATXPRES and Express Neutral files) 
through Patran's built-in legacy translators. CAD Interface supports a wider range of geometry types and is 
a more modern implementation that imports geometry via a Parasolid translation process. This is the default 
method for most CAD import types. Where an option exists, the older CAD Import can be activated by 
switching OFF the Import to Parasolid check box on the Import form. 
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Import Options
In general, the CAD model contains more data than you need for the CAE simulation model. A number of 
options for filtering and/or limiting the import are provided. When you specify a CAD package on the 
Import form, one or more subordinate forms appear so that you may define the filtering options. You can 
filter based on entity type, surface type, or CAD layers. Plan ahead in your CAD modeling, and use layers or 
colors to separate out entities that you want to exclude from the analysis model.

Parasolid Healing 
This option controls the healing of data which has performance-expensive errors. Set this option ON to 
enable healing. The input file for translation might contain geometrical and topological errors, which means 
that the data could be corrupted. To ensure precise and valid translation use this option for repairing and 
healing the geometrical and topological irregularities. Repairing involves checking the translated file for 
corrupted data and fixing the invalid data.
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If healing is enabled, the total time for the translation process is increased. Hence, if you are not interested in 
fixing performance-expensive errors, then turn OFF healing to accelerate the translation process.
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Overview of Geometry
Computer models of geometry serve many purposes. CAD geometry models can serve as blueprints for 
manufacturing, a source for technical illustrations, and a source for parts procurement. By comparison, the 
geometry modeling capabilities in Patran are directed towards creating a complete FEA model. This FEA 
model will eventually include a finite element representation of the geometry, and assignments of loads, 
boundary conditions, material properties, and element properties. The completed FEA model is what your 
analysis program eventually sees as input data. 

Creating a geometric model facilitates the use of one of Patran’s most powerful features, automated finite 
element mesh generation. In addition, you will benefit by working at a geometric level as much as possible. 
Once you have created a geometric model, you can assign loads, boundary conditions, element properties, 
and material properties directly to regions of the geometry instead of to the finite element mesh. This allows 
you to create different finite element meshes or analysis parameters while retaining the basic underlying 
definition of your model. 

With the Geometry application, you can define the physical structure of your model- the first task in 
simulating the product design. Next, you assign the finite elements mesh, loads and boundary conditions, 
and materials and element properties to the model. In many cases, these assignments are made directly to the 
geometric model.

Options for Starting the Geometry Model
Patran provides a great variety of options for creating, modifying, and qualifying a geometry model. You may 
start your model in one of three ways: 

 Select the Geometry application on the Patran Main form, then choose from over 130 Create, 
Transform, and Edit actions on the Geometry form to create new structures.

 Import models created in a CAD system into Patran using the File/Import menu option, then edit 
them. (For more information on importing CAD models, see Chapter 3.)

 Copy an existing Patran model database, and use the existing model as the basis for your 
new model.

Model Building Tasks
Patran maintains complete accuracy of the original geometry, whether it comes from a separate CAD part 
file, or from within Patran. Regardless of how you start your model, the Geometry application form provides 
numerous options for editing, managing, updating, and verifying the entities in your model. There is also 
flexibility in the sequencing of the geometry and meshing tasks. Typically you complete the entire geometry 
model first before moving on to the finite element mesh application; however, you may also complete 
geometry, then mesh your model one portion at a time.

Basic Concepts and Definitions
The topics in this section describe several key concepts within Patran geometry. It will be helpful to you to 
understand these concepts before you start building a geometry model.



63Chapter 4: Geometry Modeling
Basic Concepts and Definitions
Parametric Space and Connectivity
Patran utilizes the concept of parametric space for simpler and more efficient internal computations. In 
parametric space, a curve is defined in terms of only one parametric axis, x1. A surface is defined in terms of 
two axes,   x1 and  x2. And a solid is defined in terms of the x1, x2, and x3 parametric axes. Every object has 
a size of exactly one on each parametric axis for which it is defined. Therefore, coordinates along these axes 
always range in value between 0 and 1. 

You can use parametric space as a powerful modeling concept. Many Patran application forms and PCL 
functions allow you to specify parametric values rather than global XYZ values. For example, you can 
subdivide a highly curved surface along its parametric one-third point without having to make complex 
measurements in real space.

Note: Patran application forms refer to parametric coordinate values as C1, C2, and C3, rather than 
x1, x2, and x3.

Patran’s Mapping Functions Translate Between Parametric and XYZ Space

For each curve, surface, or solid that you construct in Patran, the software derives a unique mapping function 
(F) that can translate between the object’s set of parametric coordinates and its more standard three-
dimensional XYZ coordinates, as shown in the Patran viewport. The following illustration compares how a 
surface would look in parametric space with a realistic rendering in the viewport’s three-dimensional XYZ 
space.   

Figure 4-1  Mapping a surface from parametric space to global XYZ space 

Connectivity
Connectivity is the location and orientation of the parametric axes. The parametric axes  x1, x2, and x3 have 
a unique orientation and location on each curve, surface, and solid. For example, the following two surfaces 
are identical, but their connectivity is different.
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Figure 4-2  Two possible connectivities for a surface

For a curve, there are two possible connectivity definitions. For a four-sided surface, there are a total of eight 
possible connectivity definitions. For a triparametric solid with six faces, there are a total of 24 possible 
connectivity definitions in Patran, three orientations at each of the eight vertices.

Geometric Entities
This section provides a detailed look at the characteristics of the geometric entities that you may select as 
building blocks. 

 Point.
 Curve.
 Surface: supported types include bi-parametric, general trimmed, simply trimmed, composite 

trimmed, and ordinary composite trimmed.
 Solid: supported types include tri-parametric and boundary representation. 

The following additional entities serve as frames of reference for geometry construction, rather than building 
blocks:

 Plane.
 Vector.
 Coordinate Frame.

Points 
In Patran, all points are non-parameterized, dimensionless coordinate locations in three-dimensional XYZ 
space. You may use points by themselves to create point elements such as masses, and to construct higher-
level geometric entities.
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Curves 
A curve has one parametric dimension in space. You can subdivide a curve into 1-D elements such as truss 
or beam elements, and you can use them in geometric construction. A curve has one parametric variable, ξ1, 
used to describe the location of any given point, P, along a curve, as shown below.

Surfaces 
Patran supports simple and general surfaces. 

 Simple surfaces are regular 3 or 4-sided regions. 

In terms of parameterization, simple surfaces are two-dimensional point sets in three-dimensional 
global XYZ space. Any given point, P, on a surface can be located by the coordinates ξ1 and ξ2, as 
shown.
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 General surfaces can include more than four edges as well as interior holes or cutouts.

Each trimmed surface has an invisible associated parent surface that defines its parameterization and 
curvature. 

There are several types of general surfaces: trimmed surfaces may be either planar (stays in a two-
dimensional plane) or 3D; composite surfaces merge a collection of surfaces into one entity defined 
within a specific boundary. 
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Solids 
Patran supports simple tri-parametric solids and general boundary representation solids. 

 Simple solids can have four to six faces with no interior voids or holes. 

Most solids created with the Geometry application are tri-parametric. In terms of parameterization, 
each solid is a three-dimensional point set in global XYZ space. For any given point in the solid, P 
can be located by the three coordinates, ξ1, ξ2, and ξ3, whose values range between 0 and 1 inside 
the solid.

 General Boundary Representation (B-rep) solids are formed from an arbitrary number of surfaces 
that define a completely closed volume. B-rep solids can include interior voids or holes. 

Only the outer surfaces or faces of a B-rep solid are parameterized and not the interior.
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Planes and Vectors
Vectors and planes serve as useful entities for constructing geometry models.

 Vectors define an origin and an endpoint, for use in modeling operations such as translating 
geometry, or constructing geometry between two points. You may create vectors in Patran using 
numerous Create/Vector options. 

 Planes are particularly useful in symmetric operations, such as creating a mirror image of geometry 
components. Patran provides numerous Create/Plane options.

Coordinate Systems and Frames 
Coordinate systems define a coordinate frame of reference used in modeling operations. Patran automatically 
defines a global rectangular (Cartesian) coordinate system in every database. The system origin, 0, is indicated 
by a white plus sign in the viewport. The global axes in the lower left of the viewport indicate the current 
orientation of the global coordinate system. 

In addition to the default global coordinate system, you may create your own local coordinate systems. For 
example, if you need to create a cylinder perpendicular to a curved surface, creating a cylindrical coordinate 
system that is orthogonal (perpendicular) to the surface can make this task much easier. 

The Geometry option Create/Coord allows you to create three types of local coordinate systems: 

 Cartesian systems, which have three orthogonal axes in rectangular space.
 Cylindrical systems with axes in the radial, angular, and depth dimensions of a cylinder.
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 Spherical systems, described in terms of a radius and two principal angles. 

Figure 4-3  Coordinate Systems

Coordinate frame angles for the cylindrical and spherical coordinate frames (that is, θ and Φ) are always 
expressed in degrees.

Later, when creating a finite element model, coordinate systems help establish the principal directions in 
which your analysis results are displayed. Alternate coordinate systems are very simple to use in Patran, and 
they are closely integrated with Patran's geometric modeling operations. Nearly all of those options involving 
coordinate data support the ability to enter a coordinate system to interpret the input values 
you supply.
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Subentities
Topological entities determine adjacency between geometric entities, and identify subcomponents of higher-
order entities. While each geometric entity has a separate number, (such as Curve 1 or Surface 2), Patran 
assigns numbers to topological entities that are relative to adjacent higher order objects. For example, the 
input Surface 4.2 in a form databox denotes Edge number 2 of Surface 4. 

Each curve, surface, and solid in Patran has a set of defined topological entities, as follows: 

Congruency
Topological congruency is a prerequisite for creating a valid finite element mesh for your analysis model. It 
ensures that all regions of the model’s geometry are made into one connected entity during the meshing 
process so that the model yields meaningful analysis results. If the finite element model is not topologically 
congruent, "cracks" result, invalidating the analysis results.

To be topologically congruent, adjacent regions of geometry in your model must share matching boundaries 
and vertices. In addition, the geometric components must form a closed surface or solid region, and there 
must be no overlap between adjacent regions. The Geometry application provides several methods for 
verifying congruency and correcting incongruencies. For more information, see Ensuring Topological 
Congruency.

Creating Geometry
You will use the Patran Geometry application form for most of your geometry modeling tasks.

Using the Geometry Application Form
To use the Geometry Application form:

1. Click the Geometry button on the Patran Main form.

The Geometry Application form appears on your screen.

2. Select an Action/Object/Method combination from the drop-down menus at the top of the 
Geometry application form.

Several additional form fields display on the lower two thirds of the Geometry form that vary 
depending on the your selections for Action, Object, and Method.

Vertex Defines the topological endpoint of a curve, or a corner of a surface or a solid. A vertex is a 
subcomponent of a curve. (Every point references a vertex, but a vertex does not have to 
reference a point.)

Edge Defines the topologic curve on a surface or a solid. An edge is a subcomponent of a surface 
or solid.

Face Defines the topologic surface of a solid. A face is a subcomponent of a solid.
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The Action defines what you want to do. Actions fall into three categories: create, modify, or verify. The table 
that follows briefly describes the Action choices for the Geometry application.

Action Descriptions

Create Actions

Create Creates points, curves, surfaces, solids, planes, vectors, and coordinate frames 
based on data input or cursor-selections from the viewport.

Transform Creates additional objects by duplicating existing entities at new locations. You 
may specify the new locations by offsets, rotations, scaling, mirroring about an 
axis, and so on.

Modify Actions

Edit Modifies geometric objects to improve the model design and correct errors, such 
as breaking big objects into groups of smaller ones, and deleting duplicate points. 

Delete Eliminates objects from the database and erases them from the viewport window.

Associate / 
Disassociate

Associate joins entities, such as a surface and a tangent curve, so that they are 
meshed together. Disassociate separates them.
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Objects
The Object field defines the type of geometry. For example, if you specify a Create Action, the object defines 
what type of geometry you want to create.
 

Methods
The method specifies how the Action is going to be carried out. The choices for Method are so numerous 
that it would take many pages to list them all. An example of the Glide method is presented in the sample 
that follows this section. For a complete listing, please refer to the Patran Reference Manual, Volume 2, Part 3: 
Geometry Modeling.

Qualify Actions

Verify Identifies problem areas in your model that can then be corrected, such as gaps 
between edges of adjacent objects and missing surfaces.

Show Displays a spreadsheet form with information about geometric objects. For 
points, you may request data such as coordinate value locations and node IDs.

Object Description

Points (light blue) - a point coordinate location that has zero 
dimensions.

Curves (yellow) - a one dimensional parametric curve.

Surface Simple surfaces (green) - Parametric surfaces with 3 or 4 outer edges; 
no inner edges, holes, or cutouts. 

General surfaces (magenta) - Surfaces with more than 4 outer edges, 
and/or with inner edges, holes, cutouts. 

Solid Simple solids (dark blue) - Parametric solids with 5 or 6 faces. 

General solids (white) - Solids with more than 6 faces and/or with 
inner holes, edges, or cutouts.

Planes (pink) - a two-dimensional parametrized surface.

Vectors (blue) - a one-dimensional curve with direction and 
magnitude.

Frames (purple) - rectangular, cylindrical, or spherical frames of 
reference.

Action Descriptions
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Sample Geometry Form
The following illustration shows the selection of a Create action on the Geometry application form, with 
before and after snapshots from the viewport window. This selection, Create/Solid/Glide, creates Solid 1 
using Curve 5 as the Glide path and Surface 2 as the base surface

Note:  The Geometry portion of the Patran Reference Manual provides annotated illustrations similar 
to this one for most of the supported Action/Object/Method choices.
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Creating Trimmed Surfaces 
You must select Create/Surface/Trimmed on the Geometry application form to construct a trimmed surface 
in Patran. This form prompts you to define a surface in terms of its boundary curves, which are continuous 
closed "loops" that define both the outside boundaries of the surface, and interior holes or cutouts. This form 
also allows you to specify a parent surface from which the new surface is trimmed.

You can create the loops that form the outside boundaries and interior holes for the trimmed surface in one 
of three ways:
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 The Create/Curve/Chain form prompts you to create a continuous loop from an existing set of 
curves that are joined from end to end. This operation defines a new, single chained curve, and 
prompts you to delete the original curves. The Auto-Chain option guides you visually through the 
process of creating a chained curve from this menu.  

 The Auto-Chain button on the Create/Surface/Trimmed form allows you to create exterior and 
interior loops from existing sets of curves that are joined from end to end. This operation defines the 
new chained curves, and prompts you to delete the original curves. 

 Certain curve options, such as Create/Curve/2D Circle and Create/Curve/Conic (when used to 
form a closed ellipse), create closed curves used directly as loops in trimmed surface creation.

The Create/Surface/Composite option allows you to create a single, composite surface from adjacent planar 
surfaces. This option is useful for creating a single, meshable surface from regions with complex edge 
boundaries or multiple adjacent regions.

Creating B-Rep Solids 
A boundary representation (B-rep) solid is defined in terms of Patran surfaces which comprise the entire 
boundary of a solid. These solids may have an arbitrary number of boundary surfaces, so long as they 
comprise a closed solid region.The solids are defined using the Create/Solid/B-rep option of the Geometry 
menu form. However, before you use this option, the surfaces which bound the solid must be created or 
imported. Some guidelines for doing this properly include:

 Make sure that all surfaces are topologically congruent (e.g., they share common edges and vertices). 
In cases where surface edges do not align, consider options such as Edit/Surface/Sew or 
Edit/Surface/Match to align adjacent surfaces.

 In the case of models imported from CAD systems, make sure that its model tolerances fall within 
the geometric tolerance values of your database. For example, if your Patran database has a tolerance 
of .005 (meaning that points within this distance are at the same location), and your model is on a 
scale of units ranging from 0.0 to 0.1, you may find problems where points merge to form 
degenerate (e.g., collapsed) regions. 

Conversely, a model scale which is too many orders of magnitude larger than the tolerance may 
mismatch adjacent surfaces. This tolerance value is database-specific and defined when you initially 
create the database using the File/New menu pick.

 Use the Verify/Surface/Boundary from the Geometry menu to make sure that there are no holes 
caused by missing surfaces in your model. Alternatively, you may wish to shrink surfaces towards 
their centroid using the Geometric Shrink option of the Display/Geometry utility menu, to observe 
their individual boundaries.

Check your B-rep solid for the following three items: 

 The group of surfaces that will define the B-rep solid must fully enclose a volume.
 The surfaces must be topologically congruent. That is, the adjacent surfaces must share a common 

edge.

Important:  At this time, Patran can only create a B-rep solid with an exterior shell, and no interior shells.
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Working with Imported CAD Models 
In some cases, you can use imported CAD geometry without modification. However, models are not always 
prepared in CAD systems with the ability to analyze them in mind. It is common to modify imported 
geometry, to remove extraneous detail, and to construct missing surfaces needed for topological congruency. 

Some of the most common problems with imported CAD data, and suggested solutions within Patran, are 
as follows. 

Remove Excess Detail 
There may be features in the imported CAD geometry data that add greatly to the complexity of a model, 
such as rows of small bolt holes in a component. If you allow numerous small extraneous features that are not 
critical to performing an analysis to remain in the geometric model, they will greatly increase the number of 
finite elements required in an analysis model and will cause a substantial increase in the run time of the 
analysis. Here you must use your engineering judgment to determine which features are less important and 
which must be retained for accuracy. 

Use the following Patran features to implement your choices for simplifying your model and removing excess 
detail:

 Plan ahead in your CAD modeling, and use layers and/or colors to separate out entities that you 
want to exclude from the analysis model. 

 Use filtering options to restrict input to specific types of entities. For example, bring in solids only, 
or curves only, to rebuild the model in Patran. The filtering options are found on a subordinate form 
nested under the Import form (e.g., when the Source file type is set to IGES, an IGES subordinate 
form provides filtering options).

 Use imported CAD geometry as a base to construct simpler analysis geometry in Patran. Here the 
vertices, curves and/or bounding surfaces of the original CAD model are used as a basis for 
constructing geometry using features available in Patran's Geometry menu options.

 There may be cases where a larger surface or solid is represented by several smaller regions, adding to 
its complexity. You can select Create/Surface/Trimmed and Create/Solid/B-Rep to simplify 
complex geometry by basing it on outside edges or faces.

  Alternatively, in the case of many adjacent entities, consider approaches for merging adjacent 
surfaces such as the action Create/Surface/Composite, or other construction methods. Whichever 
approach you choose, a certain amount of simplification can have a major impact in both the time 
spent generating a finite element mesh, and the computing time required for running an analysis.

Add Missing Surfaces
Solid CAD models may not have to be closed 3D solids for drafting or layout purposes; hence, surfaces which 
enclose the solid may be missing. To determine these missing surfaces, use the Verify/Surface/Boundary 
action. 

 For cases where a regular number of edges (e.g., 3 or 4) will enclose the region, select a Geometry 
action such as Create/Surface/Edge to fill in missing surfaces by specifying the edges of adjacent 
surfaces.
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 When a region is bounded by more than 4 sides, select the Geometry action 
Create/Surface/Trimmed In this case, you must first create a composite curve representing the 
exterior boundary using either the Create/Curve/Chain option or the Auto Chain button on the 
Create/Surface/Trimmed form. An alternative to this is to break the region into several simple 
biparametric surfaces.

Repair Incomplete Entities 
Popular CAD data formats such as the popular IGES format are often extremely broad standards that include 
many different types of geometric data. IGES is a very rich standard, and not all entity types in IGES are 
supported by every CAD system. This may result in simplifications such as curves being translated as a series 
of points, or a regular solid being represented by its boundary surfaces. 

In cases like this, you must use Patran geometry actions to convert these incomplete geometries to entities 
that are clearly defined.

For example, use the Create/Curve/Spline option for fitting a curve to a set of points, or use the 
Create/Solid/B-rep option for creating a bounded solid from its surrounding surfaces.

Checking the Geometry 
When you create or import a geometric model into Patran, your primary goal is to produce a model which 
can be used for finite element analysis. The following sections describe some requirements for effective 
geometric modeling and suggest ways to verify that your model meets those requirements.

Ensuring Topological Congruency
Topological congruency is a prerequisite for creating a valid finite element mesh because it assures that all 
regions of the model’s geometry can be made into one connected entity during the meshing process, so that 
it can be analyzed. To be topologically congruent, your model must meet the following requirements:

 Adjacent regions of geometry share matching boundaries and vertices. 
 The geometric components form a closed surface or solid region. 
 There is no overlap between adjacent regions. 

The following illustration shows an example of congruent geometry.
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Figure 4-4  Congruent geometry example 

When edges of adjacent geometric regions are congruent (i.e., they match exactly), their meshes normally 
have the same number of nodes along common edges. In addition, the nodes along common edges are 
coincident; that is, they line up in pairs at the same locations along the common boundaries of the geometric 
regions. This includes matching pairs of corner nodes, or vertices.

During the equivalencing phase of the meshing process, these pairs of coincident nodes along the boundaries 
of the geometric regions are sewn together, so that the separate regions of the geometry form one connected 
entity that is ready to be analyzed.   
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Finding Incongruencies
The Geometry form selections Verify/Surface/Boundary and Verify/Solid/B-rep help you to locate areas of 
your model that are topologically incongruent. The Update Graphics form appears after you press Apply on 
the Geometry form. This form allows you to plot incongruent surfaces within a model. 

Plot Incongruent Surfaces Plots only the surfaces that are incongruent or non-manifold. All other 
surfaces are erased from the viewport. Patran will plot markers along the 
edges of the incongruent surfaces.

Plot All Geometry Plots all geometry that is associated with the current viewport’s 
posted groups.

Erase Markers Erases the markers that were plotted along the edges of the 
incongruent surfaces.

Erase Congruent Surfaces Erases any surface that becomes congruent in the model. You do not need 
to select the Plot Incongruent Surfaces button to update the display of the 
viewport.
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Correcting Incongruencies
The following figure shows two examples of incongruent geometry. 

Figure 4-5  Noncongruent geometry with missing vertices 

You may be able to get a consistent mesh for the leftmost surface if the edge of region 1 has exactly twice the 
number of elements as region 2 and region 3, and the mesh spacing is uniform. In this case the nodes could 
be equivalenced. However, if this surface were then remeshed--for example, with a specific mesh seed applied 
to one of these interior boundary edges--this would probably yield a mesh that could not be equivalenced.

In addition, if point 10 is not precisely in the center, the meshes for regions 1, 2, and 3 would not be likely 
to equivalence. Without equivalencing, these regions remain independent and unconnected. To make this 
surface congruent, choose either:

 Edit/Surface/Break, specifying to break surface 1 at point 10.

-or-

 Edit/Surface/Edge Match, with the Surface-Point option specified. 

The surface on the right half of the previous figure shows a gap between two pairs of surfaces that is greater 
than the Global Model Tolerance. This means when you mesh the surface pairs, coincident nodes will not be 
created along both sides of the gap. To make this surface congruent, choose one of the following actions:

 Create/Surface/Match.

-or-

 Edit/Surface/Edge Match.

Avoiding Small Angles at Surface Corners
Try to keep the inside corners of the surfaces to 45 degrees or more. The reason is that when you mesh surfaces 
with quadrilateral elements, the shapes of the elements are determined by the overall shape of the surface. The 
more skewed the quadrilateral elements are, the less reasonable your analysis results might be. (For further 
recommendations, please consult the vendor documentation for your finite element analysis code.)



81Chapter 4: Geometry Modeling
Checking the Geometry
Figure 4-6   Surfaces with and without sharp corners

Verifying and Aligning Surface Normals
The direction of the out-of-plane normal vector of a surface is an important consideration for applying 
analysis data such as loads, boundary conditions, and element properties. In general, try to maintain the same 
normal direction for all surfaces in a model. The following figure shows opposing normals for two surfaces.

Use the Geometry application’s Edit/Surface/Reverse form to display the surface normal vectors, and to 
reverse or align the normals for a group of surfaces. This form has a button labeled Draw Normal Vectors that 
displays the positive surface normal vectors within your display. Alternatively, the Show/Surface/Attributes 
form can be used to display these normals.

You can also verify normals indirectly while constructing a surface, by displaying the parametric directions of 
the surface. To do this, choose Display /Geometry from the Main menu, select the Show Parametric 
Direction toggle, and then press Apply. These parametric directions will be displayed as lines at the parametric 
origin, labeled 1 and 2. The surface normal can be determined from these directions using what is known as 
the "right hand rule"--positioning your right hand so your fingers curl from axis 1 towards axis 2, the thumb 
pointing in the normal direction. 
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Put another way, the cross product of these two parametric axes produces a vector in the surface normal 
direction. To reverse the normal direction of a surface, use the Edit/Surface/Reverse form discussed above. 
This form allows you to select one or more surfaces, and reverses their normals by reversing their C1 and C2 
parametric directions.

Additional Considerations
Beyond these basic criteria, some of the other goals in using Patran's geometric modeling in Patran include 
creating regions that mesh easily, contain separate regions as needed for the assignment of material and 
element properties, and contain features that facilitate the assignment of loads and boundary conditions. 

To facilitate these goals, Patran contains numerous features for operating on existing geometry to simplify its 
analysis (for example, options to subdivide geometry into multiple regions, to work in multiple coordinate 
frames, and to use construction operations such as intersection and projection). 

Above all, a geometric model in Patran is meant to be interacted with--an analysis of your model not only 
provides verification of whether it meets your design criteria, but also yields valuable feedback which can be 
used to further improve this design. You can then perform subsequent analyses to verify these changes. 

This iterative cycle of adaptive analysis and design modification is central to the value of automated design 
analysis tools such as Patran, and it underscores the importance of using its geometric modeling features as a 
means of improving an existing design. 

A Case Study of a Lug
In lieu of constructing new models from scratch, Patran supports direct interfaces to all major CAD systems. 
This added feature of using an existing CAD geometry model minimizes repetitive modeling efforts and 
ensures better accuracy between a CAD design model and its intended analysis model. 

Problem Description
This lug model is simply supported at the bottom and is subject to a quadratic contact load as shown by 
Figure 4-7. The associated geometric, load, and material properties are described by Table 4-1.
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Figure 4-7  Loads on the Lug 

Table 4-1   Properties of the Lug 

Elastic Modulus, E = 10E6 psi

Poisson’s Ratio, ν = 0.3

Contact Load 12.5*(|x|-2)**2
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Conceptual Model
Unlike the case study of the annular plate where we idealized the solid model with two dimensional 
approximation, this example illustrates the versatility of Patran in handling arbitrary solids. We import the 
existing Parasolid geometry into our database as the foundation of our analysis, utilize the highly automated 
Tetmesh approach to generate appropriate three dimensional elements, and incorporate all relevant 
functional assignments (materials, properties and loads/boundary conditions) to complete our analytical 
model.

Analysis Procedure

Setup the Analysis Project 

Creating a New Database

 On the Patran Main Menu, select File >> New. The New Database form appears.
 Enter the name lug in the Filename textbox.
 Click OK. 
 The New Model Preferences from appears. This form allows you to specify the generic analysis 

parameters for the model.

Selecting Analysis Parameters

 Set the Tolerance to Default.
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 Choose MSC Nastran from the Analysis Code pull-down menu.

 Choose Structural from the Analysis Type pull-down menu and click OK.

Import the Geometry 

Importing a Parasolid Geometry 

 On the Patran Main Menu, select File >> Import. 
 The Import form appears.
 On the Import form, select Source >> Parasolid xmt, and then click on the Parasolid xmt Options.
 From the Option form, select Model Units button. Change the unit to 39.37(Inches) under the 

Model Unit Override window. Click OK to return to the Option form, and click OK one more 
time to return to the Import form.

 Select the lug.xmt in the Filename field and click Apply.
 Now change the view to Isoview 1 by clicking on the Isoview1 button on the Main menu. Also, turn 

ON the Display Line Icon.
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Create a New Coordinate System 

 On the Patran Main Menu, click on the Geometry Application button.
 At the top of the form, select Action >> Create, Object >> Coord, Method >> 3Point. 
 Change the Coord ID List to 99. Enter Origin = [3,6,0], Point on the Axis 3 = [3,6,1], and Point on 

Plane 1-3 = [4,6,1]. Click Apply. 

Create the Finite Elements 

Create a Solid Mesh with Tet10 Elements

 On the Patran Main Menu, click on the Elements Application button.
 On the top of Finite Element form, select Action >> Create, Object >> Mesh, Type >> Solid. Use 

this combination to create a solid mesh.
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 Change the Global Edge Length to 0.4 and cancel the selection, Automatic Calculation. 
 Select TetMesh in the Mesher field.
 Using the Element Topology pull-down menu, highlight Tet10. This selects the type of element 

that will be used to mesh the solid geometry. 
 Place the cursor in the Input List textbox and cursor select both solids (or type in Solid 1 2). Click 

Apply. 

Equivalencing the Mesh

 On the top of the Finite Element form, select Action >> Equivalence, Object >> All, Method >> 
Tolerance Cube. This will equivalence all the nodes. 

 Click Apply.
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Model the Materials 

Create a Material

 On the Patran Main Menu, click on the Materials Application button.
 On the top of the Materials form, select Action >> Create, Object >> Isotropic, Method >> Manual 

Input. 
 In the Material Name textbox, enter “steel.”
 Click on the Input Properties button.
 Specify the Material Properties of Steel
 On the Input Options form, enter 30e6 in the Elastic Modulus databox.
 In the Poisson’s Ratio databox, enter 0.3.
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 Click OK to close the Input Option form, and then click Apply on the Materials form.

Define Element Properties 

Create the Element Properties

 On the Patran Main Menu, click on the Properties Application button.
 On the top of the Properties form, select Action >> Create, Object >> 3D, Type >> Solid. 
 In the Property Set Name textbox, enter prop_1.
 Click on the Input Properties button.
 On the Input Properties form, click in the Material Name listbox and select steel from the Material 

Property Set list. Click OK.
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 On the Element Properties form, click on the Select Members textbox. Select and Add all the 
geometry entities.

 Click OK to close the Input Properties form, and then click Apply on the Properties form.

Create a PCL Function Representing the Loading Condition 

 On the Patran Main Menu, click on the Fields Application button.
 On the top of the Loads/BCs form, select Action >> Create, Object >> Spatial, Method >> PCL 

Function. Name the Set quadratic_loading, and select Vector as the Field Type.
 Select Real for the Coordinate System Type and enter Coord 99 in the Coordinate System textbox.
 In the second component field, enter the equation 12.5*(abs(‘x)-2.)**2.

Make sure all the integers have a decimal point. 
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 Click Apply.

Simulate the Loads and Boundary Conditions (LBC) 

Create a Load Based on the PCL 

 On the Patran Main Menu, click on the Loads/BCs Application button.
 On the top of the Loads/BCs form, select Action >> Create, Object >> Force, Type >> Nodal. 

Name the Set Contact_load, and click on the Input Data button.



Patran User’s Guide
A Case Study of a Lug

92
 On the Input Data form, click in the Force databox and then select the quadratic_loading inside the 
Spatial Field databox. Click OK.

 Click on the Select Application Region button.
 On the Select Application Region form under Geometry Filter, click on Geometry.
 Place the cursor in the Select Geometric Entities databox. Next, use the cursor to select the bottom 

face of the top solid from the screen (or type in Solid 2.3). Click Add and then click OK.
 Click Apply in the Loads/Boundary Conditions form.
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Create a Displacement

 On the Patran Main Menu, click on the Loads/BCs Application button.
 On the top of the Loads/BCs form, select Action >> Create, Object >> Displacement, Type >> 

Nodal.
 Name the set support.
 Click on the Input Data button.
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 On the Input Data form, enter <0,0,0> for Translations and leave the Rotations field blank. 
Click OK.

 Click on the Select Application Region button.
 On the Select Application Region form under Geometry Filter, click on Geometry.
 Place the cursor in the Select Geometric Entities databox. Next, use the cursor to select the bottom 

face of the bottom solid from the screen (or type in Solid 1.3).
 Click Add, and then click OK.
 Click Apply on the Loads/Boundary Conditions form.
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Run MSC Nastran 

Create the MSC Nastran Input (Bulk Data) File

 On the Patran Main Menu, click on the Analysis Application button.
 On the top of the Analysis form, select Action >> Analysis, Object >> Entire Model, Method >> Full 

Run.
 Click on the Solution Type button.
 On the Solution Type form, select Linear Static. Click OK.
 Click Apply on the Analysis form.
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 The analysis will take a few seconds before finishing. A file by the name lug.bdf is created and 
submitted to MSC Nastran. This assumes proper configuration of the P3_TRANS.INI file 
(Windows) or the site_setup file (Linux), which point Patran to the proper location of the MSC 
Nastran executable.

 Translate the Results into Patran for Results Postprocessing
 On the top of the Analysis form, select Action>>Access Results, Object>>Attach XDB, 

Method>>Result Entities.
 Click on the Select Results File button.
 On the Select File form, select lug.xdb. Click OK.

Results Postprocessing 

Create Fringe and Deformation Plot

 On the Patran Main Menu, click on the Results Application button.
 On the top of the Result form, select Action >> Create, Object >> Quick Plot. 
 In the Select Result Cases listbox, select Default, Static Subcase.
 In the Select Fringe Result listbox, select Stress Tensor.
 In the Select Deformation Result listbox, select Displacement, Translational.
 Click Apply.
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Overview of Meshing
Finite element modeling is central to the ability to perform an engineering analysis of a model using a 
computer. One of the core strengths of Patran is its ability to help you create a finite element model, either 
from an existing geometry model or through direct finite element operations. 

The equations needed to determine the behavior of an entire complex model are often so complicated that it 
would be impractical to derive or solve them. The finite element method solves this problem by dividing the 
complex model into an assembled group of finite elements, small interconnected pieces commonly referred 
to as a mesh. The elements in a finite element model have common geometric shapes such as rectangles, 
triangles, and tetrahedra. They also include connecting points called nodes, and assigned material and 
element properties.

Once the model is divided into finite elements, the computer analysis program can then use efficient 
mathematical equations to calculate the behavior of the individual elements, taking into account the 
interdependence of adjacent elements and the assigned properties. By converting the geometry model into a 
finite element model composed of interconnected pieces, a computer can analyze the model’s behavior simply 
and accurately.

Figure 5-1     A geometry model versus a finite element representation

In many structural analyses, for example, each element is viewed as a set of springs. These springs are attached 
at their corner points (known as nodes) to provide an interdependent representation of the entire model's 
behavior. Mathematically, this is accomplished by having each element contribute terms which are combined 
to form a matrix of constants known as a stiffness matrix. This matrix is combined with the mass, material, 
and other properties of these elements to form a global matrix [k]. The global matrix then becomes part of a 
matrix equation that relates the loads {P} with the resulting displacement {d}, as shown:

            {P} = [k]{d}

The analysis program solves this equation to produce displacements. These displacements are then used to 
compute other behaviors such as stress and strain at points in the model. Depending upon the capabilities of 
your analysis program, you can also solve for other behaviors such as thermal or acoustic properties, using 
similar matrix equations describing these behaviors. 
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Finite Element Modeling Capabilities
Patran contains many capabilities to help you create the right kind of finite element mesh for your model, 
and the creation of finite elements may often be a highly automated process. For some models, even a single 
automated meshing operation, followed by another step to join mesh regions together, may suffice.

Patran provides the following capabilities for finite element modeling (FEM):

 Mesh seeding tools to control specific mesh densities in specific areas of your geometry. 
 Several highly automated techniques for mesh generation. 
 Equivalencing capabilities for joining meshes in adjacent regions. 
 Tools to verify the quality and accuracy of your finite element model. 
 Capabilities for direct input and editing of finite element data. 

 These tools help minimize the human effort needed to reach your most important goal--understanding the 
behavior of a geometric model--while providing the flexibility to have as much control over the process as you 
need.

Basic Concepts and Definitions
Following are several topics that include basic concepts and definitions related to the Finite 
Elements application.

A Look at Finite Element Types
Finite elements themselves are defined by both their topology (i.e., their shape) and their properties. For 
example, the elements used to create a mesh for a surface may be composed of quadrilaterals or triangles. 
Similarly, one element may be a steel plate modeling structural effects such as displacement and rotation, 
while another may represent an air mass in an acoustic analysis. Both the shapes and properties supported 
depend upon the analysis program you are using with Patran, as defined in your Analysis Preferences.

At this stage of using Patran, where you are creating a finite element mesh using the Finite Elements 
application form, elements are defined purely in terms of their topology. Other properties such as materials, 
thickness and behavior types are then defined for these elements in subsequent applications, and discussed in 
later chapters of this guide. 

The table below describes the element topologies supported by Patran. The columns in the table provide the 
following information:

 The left-hand column lists seven element shapes and illustrates each with a common node 
configuration. 

 The Structural Uses column describes typical usage conditions for the element shapes. For example, 
use Bar-shaped elements if you plan to define the element properties as bars, springs, or gap 
elements.

 The Mesher Support column indicates which mesher-node configuration combinations are 
supported for each element shape.
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A complete description of the Patran element library, including numbering conventions and parametric 
coordinates, is available in Part 4 of the Patran Reference Manual.

Mesh Generation Techniques
There are four basic mesh generation techniques available in Patran: IsoMesh, Paver Mesh, Auto TetMesh, 
and 2-1/2D Meshing. This section describes each meshing technique. Selecting the right technique for a 
particular model must be based on geometry, model topology, analysis objectives, and engineering judgment. 

Element Shape
 Node Configurations and Mesh 

Techniques Supported Structural Uses

Point Use Point for a concentrated mass, 
spring, or damper to ground.

Bar Isomesh supports Bar1, Bar2, and Bar4 
elements.

Use Bar when the stress state varies in 
one dimension, and when properties 
of the element are defined along a 
curve or straight line. 

Tria Isomesh and Paver support Tria3, 4, 6, 
7, 9, and 13 elements.

Use Tria and Quad when the stress 
state varies in two dimensions and is 
constant in the third.

You can also use Tria and Quad when 
one dimension of the area to be 
modeled is very small in comparison 
to the other two. 

Quad Isomesh and Paver support Quad4, 5, 8, 
9, 12, and 16 elements.

Tet Isomesh supports Tet4, 5, 10, 11, 14, 15, 
16, and 40 elements. 
Tet Mesh - Tet4, 10, and 16.

Use Tet, Wedge and Hex when the 
stress state varies in all three 
dimensions, and all three dimensions 
of the area to be modeled are 
comparable.

Patran supports a variety of node 
configurations for each of these 
elements. 

Wedge Isomesh supports Wedge6, 7, 15, 16, 20, 
21, 24, and 52 elements.

Hex Isomesh supports Hex8, 9, 20, 21, 26, 
27, 32, and 64 elements.
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IsoMesh
This approach creates elements within a regularly shaped region of geometry via simple subdivision.

Figure 5-2   Example of solid IsoMesh

Some key features of the Isomesh approach are as follows:

 It requires regular regions of surface or solid geometry. Surface regions must have three or four sides, 
while solid regions may contain five or six faces. 

 By default, it creates a consistent number of elements in each direction, based on a parameter known 
as the Global Edge Length. Element density and spacing can be controlled via the use of mesh seeds, 
which can also be used to create a different element densities on opposing edges or faces of a region.

 It can create Quad or Tria elements on surface regions, and brick elements in solid regions. 
 For so-called "degenerate" regions, such as triangular surfaces or wedge-shaped solids, where one 

edge or face is collapsed, appropriate degenerate Tria or Wedge elements are created at the 
degenerate point or edge.

 It is the only approach that automatically meshes a geometric region with brick elements. 

Paver
The Paver is an automated surface meshing technique that you can use with any arbitrary surface region, 
including trimmed surfaces, composite surfaces, and irregular surface regions. Unlike the IsoMesh approach, 
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the Paver technique creates a mesh by first subdividing the surface boundaries into mesh points, and then 
operates on these boundaries to construct interior elements.

Figure 5-3  Example of Paver mesh technique

Some of its key features are:

 This approach is valid for surface meshes only. 
 It can be used to create Quad or Tria element meshes. Quad meshes can contain some triangles, due 

to the nature of the approach.
 Either mesh seeds or the Global Edge Length parameter on its meshing form are used to control 

element density.
 The Paver method accommodates associated geometry, such as a curve lying on a surface which has 

been associated with that surface using the Associate/Curve/Surface option of the Geometry 
application form. If such a curve has mesh seeds assigned to it, the Paver ensures that the mesh passes 
through these mesh seed points.

 Adjacent regions can be meshed with either the Paver or IsoMesh approach. The mesh density along 
a common edge becomes a default mesh density for that edge of the adjacent region.
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Hybrid Mesher
The Hybrid mesher is a surface mesher that is used internally by Tetmesher. It can be used for QUAD 
dominant mesh on any surface. The Hybrid mesher recognizes mesh seeds and hard points, and its curvature 
check automatically refines mesh along highly curved edges. The mesh created by it, is generally more regular 
or “well - ordered” than Paver but not as regular as Isomesh. Therefore, it is preferable to Paver for some 
geometries and provides an alternative when the Paver mesher produces a poor or unacceptable mesh.

Some of the limitations of Hybrid mesher are:

 It does not recognize hard curves.
 It generates more TRIAs than Paver.
 It generally generates poor elements/meshes on “problem geometry” (i.e. slivers, re-entrant corners, 

short edges).
 It is restricted by surface boundary, i.e., each surface is meshed independently and not collectively.



Patran User’s Guide
Basic Concepts and Definitions

106
Auto TetMesh
The Auto TetMesh approach is a highly automated technique for meshing arbitrary solid regions of geometry. 
It creates a mesh of tetrahedral (4-noded solid) elements for any closed solid, including boundary 
representation (B- rep) solids, as well as regular solid regions. 

Figure 5-4  Auto TetMesh technique

Some key features are:

 This approach meshes complex solid regions with little user input.
 Tetmeshing is a valid technique for meshing boundary representation solids, such as solid models 

imported from most CAD systems.
 Curvature-based meshing creates high quality meshes in curved regions. You can specify the density 

of the mesh in curved regions relative to the global element size.
 Proximity-based meshing produces high quality meshes through the thickness of thin walled 

sections.
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2-1/2D Meshing 
A planar 2D mesh can also be transformed to produce a 3D mesh of solid elements, using sweep and extrude 
operations. 

Important points to note are:

 The direction and element density in the sweep or extrude direction can be specified with this 2D to 
3D transformation approach.

 This technique produces elements that maintain no associativity with any parent geometry. This 
prevents subsequent loads, boundary conditions and properties from being assigned via geometric 
entities for these elements. 

Mesh Density
To generate a mesh, Patran must know what size of elements to use for each region of the geometry. Moreover, 
you may wish to adjust the number of elements upward or downward for a specific area of the model. For 
example, you may want to increase the number of elements in an area of high stress or temperature to get a 
more accurate result, or decrease the number of elements in a less critical region to improve the analysis run 
time. 

There are several tools available in Patran for controlling your mesh size and density, including mesh seeds, 
mesh density, and mesh density of adjacent regions. These tools combine to allow rapid meshing of geometric 
model, while providing a high degree of control over the nature of your finite element mesh.
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When you create a mesh in Patran, the mesh density along each edge of a region is chosen according to the 
following order of precedence:

 Mesh seeds. 
 Mesh density of adjacent region. 
 Global Edge Length parameter setting.

Mesh Seeds
Mesh seeds are points explicitly defined along an edge of your model to specify where node locations will be 
along that edge. These seeds can be uniform, or vary linearly towards either end, both ends, or the center of 
the edge. You can even specify specific individual locations for mesh seeds along an edge.

Figure 5-5   A mesh transition using mesh seeds

These mesh seeds are created using the Create/Mesh Seeds option on the Finite Elements application form, 
with methods including Uniform, Bias, Curve Based, and Tabular. Like other Patran entities, these mesh 
seeds can also be redefined using a subsequent Create option, or deleted using Delete/Mesh Seeds.

Adjacent Meshes
When you create a mesh in a geometry region, the mesh density created along an edge will normally be used 
in the meshing of any adjacent regions sharing that edge. In addition, Patran uses a concept of mesh paths to 
guide the subdivision of geometry regions when using the IsoMesh approach. 

Simply put, Patran projects a specified mesh density to the opposing edge of a region, and then to an adjacent 
region, until it reaches the end of a "path." The figure shown here displays the path of the specified mesh 
densities, and how they affect the meshing of the overall model.
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Figure 5-6  Mesh path examples

Global Edge Length
Each variation of the Create/Mesh form contains a parameter called Global Edge Length that defines the 
approximate length of each element edge. Patran uses this parameter to subdivide each boundary edge of your 
model into an integer number of elements yielding elements closest to this edge value, using 
the relationship: 

 

When there are no other constraints on mesh size, such as mesh seeds or adjacent meshes, the Global Edge 
Length is used to define the mesh size.

Number of Elements Longest Geometry Edge Length
Global Edge Length

-----------------------------------------------------------------------------=

Important:  Set this value explicitly whenever you perform a meshing operation. The default value found 
upon entering this form can result in an extremely dense mesh, if it is very small relative to the 
dimensions of your geometry.
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Equivalencing
Many geometry models in Patran consist of multiple regions sharing common boundaries. Finite element 
meshing in Patran is always performed one region at a time, even when multiple geometric regions are 
selected in the meshing form. 

This means that by default, the elements of one region are not connected to the elements of another region, 
and would not share behavior across their nodes. To quickly correct this, Patran provides a feature known as 
equivalencing to join together nodes at common locations. This feature can be accessed via the Equivalence 
action on the Finite Elements application form.

The equivalencing operation itself is very straightforward; each node is checked for neighboring nodes within 
a specified tolerance value. If two or more nodes are within this tolerance, they are combined as one node 
containing the lowest numbered node number. The following figure shows the equivalencing process.

You have the option of equivalencing all nodes in a region, or just those nodes corresponding to a specified 
group or list, as discussed in Chapter 2 of this guide. Once the requested nodes are equivalenced, all references 
to the original higher numbered nodes (such as element definitions, loads, and boundary conditions) are 
automatically changed within Patran to reflect the new equivalenced node numbers.

The equivalencing option allows you to select nodes to exclude from equivalencing. This is useful for cases 
where there are coincident nodes that you wish to keep physically separate. In addition, the value and 

Important:  Equivalencing must be explicitly performed by you prior to analysis. Failure to equivalence 
generally produces invalid analysis results: for example, unconnected regions which are free to 
fly off into space in a structural analysis. Patran does not automatically inform you that regions 
have not been equivalenced prior to an analysis.
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measurement technique for the equivalencing tolerance value can be set using the 
Equivalence action.
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Optimizing
No matter how your finite element model is created--either by meshing or by direct finite element modeling 
operations--there is one short, painless operation that can speed up your analysis substantially. This 
operation, known as optimization, simply renumbers your nodes or elements to decrease the run time of the 
problem.

In an analysis, terms from each finite element combine to form a symmetric matrix that is sparse, containing 
many zero terms. As part of solving this matrix equation, by essentially inverting the matrix, many finite 
element solvers have a solution time that varies with the bandwidth of the matrix. The bandwidth is the 
maximum width of non-zero terms from the matrix diagonal. The figure below shows what this bandwidth 
looks like physically within the matrix equation.

Figure 5-7   A Sparse, Symmetric Matrix

Other solvers are based on a similar criteria of wavefront, based on the number of active columns in a matrix 
row. By renumbering nodes or elements, the rows and columns of the matrix can be rearranged to reduce this 
bandwidth or wavefront, optimizing your run time. In Patran, the Optimize action from the Finite Elements 
application form performs this optimization, based on analysis-specific criteria documented in Part 4 of the 
Patran Reference Manual.

Creating a Finite Element Model
To create the finite elements mesh, Patran supports a variety of element shapes and node configurations, and 
its mesh creation tools include several automated meshing techniques. 
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The Finite Element Application Form
The Finite Elements application form provides numerous Action/Object/Type combinations that create, 
modify, and qualify the finite elements model to facilitate valid analysis results.

To use the Finite Element Application form:

1. Click the FE (Elements) application button on the Patran Main form.

The Finite Elements application form appears in your viewport.

2. Select an Action, Object, and Type using the drop-down menus at the top of the form.

The rest of the form varies depending on what you select for these menus.

Actions
The actions create, modify, and qualify all of your mesh related objects. The table that follows describes the 
action choices for the Finite Element application. 

Action Descriptions

Create Actions

Create Creates a variety of new mesh-related entities: a mesh generated by one of the 
automated mesh techniques, mesh seeds to vary the density of the mesh, 
individually designed elements and nodes, and additional objects.

Transform Creates nodes and elements by translating, rotating, or mirroring existing ones.

Sweep Creates new mesh elements by sweeping a set of existing elements along one of ten 
path types, such as Arc, Extrude, Glide, Glide-Guide, and Normal. Sweep can 
convert a surface (2D) mesh into a solid (3D) mesh by sweeping it along a normal 
perpendicular to the surface.

Modify Actions

Modify Modifies one or more attributes of entities such as nodes, elements, and multipoint 
constraints. This can include renumbering nodes and elements, splitting one into 
two or more elements, and more. Modify can also be used to optimize element 
shapes and modify the arrangement of mesh seeding.
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Objects
The Objects are your mesh related entities. These include items such as a mesh, individual nodes, and 
elements. The table that follows describes the Objects you may choose on the Finite Elements application 
form. 

Delete Removes entities from the model, such as nodes, elements, and mesh seed 
definitions.

Renumber Modifies the ID numbering of elements or nodes.

Associate/

Disassociate 

Modifies nodes and elements so that they are either associated with or disassociated 
from geometric structures. To apply loads, boundary conditions, and properties 
directly to the geometry, mesh entities must be associated with geometric entities.

Qualify Actions

Verify Provides numerous quality tests for the finite element model, including checks of 
element distortion, element duplication, and node/element ID numbering.

Equivalence Improves the finite element model by eliminating duplicate nodes, either at the 
same location or within the Equivalencing Tolerance distance. 

Optimize Minimizes the CPU time, memory, and disk space needed to solve the stiffness 
matrix portion of the analysis, by renumbering the nodes or elements in the model. 
The optimization method varies, depending on the analysis model, type, and code 
in use. 

Show Displays a variety of information about finite element objects. For example, for 
selected groups of elements, shows coordinate systems, IDs, load and boundary 
conditions, material property ID number, element properties, and associated 
results. 

Object Descriptions

Mesh The finite element method requires that you divide the analysis model into 
interconnected pieces called elements, to which separate analysis equations are 
assigned. A set of these interconnected elements is referred to as a mesh. 

Mesh Seed Mesh seeds are points that can be explicitly defined along an edge of your model, 
to specify where node locations will be along that edge. These seeds can be 
uniform, specified at individual locations, or vary linearly towards either end, both 
ends, or the center of the edge. 

Mesh Control Mesh control allows you to specify a particular global edge length for selected 
surfaces for use with any of the auto meshers. This option allows you to create 
meshes with transition without having to do so one surface at a time.

Node A node is the finite element model equivalent of a vertex in geometry. Nodes are 
the connection points between adjacent elements.

Action Descriptions
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Types
Type specifies how the mesh action is carried out. The choices for Type vary according to the Object you 
selected. A few examples are shown in the following sections. For a complete listing, please refer to the Patran 
Reference Manual, Volume 2, Part 4: Finite Element Modeling.

Sample Finite Element Forms and Subforms
Three sample Finite Element Modeling forms are shown on the following pages:

 The form for the selection Create/Mesh/Solid.
 The Isomesh Parameters subform.
 The form for Create/Mesh Seed/Two-Way Bias.

Element An element is one discrete piece of a mesh; it may be one of several standard shapes 
such as quad and tetrahedral, and can have different numbers of node points along 
its edges.

MPC (multipoint 
constraint)

MPCs are a substitute for finite elements that you can use more easily to model 
certain physical phenomena, such as rigid links, joints (revolutes, universal, etc.), 
and sliders, to name a few. MPCs are treated as elements in Patran; they display as 
lines between nodes.

Superelement This object is currently available only for the MSC Nastran analysis preference. It 
groups several elements as one large element.

Connector

DOF List

Object Descriptions
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Create/Mesh/Solid Form
Meshing is the process of automatically creating finite elements from geometry or other element data in 
Patran. It is controlled using the FEM Create/Mesh form, shown in the following illustration. 

Node ID List and 
Element ID List

Assigns an optional list of ID numbers for a new set of nodes and elements. If not 
specified, ID values will be assigned consecutively starting with the node and 
element ID shown.

Global Edge Length Specifies a real value to assign the default element edge length for a given mesh. 
This value does not override any predefined mesh seeded edges. Global edge 
lengths will only be applied where mesh seeds have not been defined.

Mesher Specifies which mesh technique to use.
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IsoMesh Parameters Subordinate Form
This form appears when the IsoMesh Parameters button is selected on the Finite Elements application form. 

Sample Create/Mesh Seed/Two Way Bias
Create mesh seed definition for a given curve, or an edge of a surface or solid, with a symmetric nonuniform 
element edge length, specified either by a total number of elements with a length ratio, or by actual edge 

Isomesh 
Parameters...

Brings up the Isomesh Parameters form that enables you specify the Isomesh 
application parameters.

Node Coordinate 
Frames...

This allows an Analysis and a Reference Coordinate system to be defined for the 
next mesh of nodes.

Element Topology Choose the type of element to create from the given list. Available elements to 
choose from here are Hex6, Hex9, and Hex20.

Solid List Specifies solids to mesh by either cursor selecting existing solids, or by specifying 
the solid IDs. 

Isomesh on 
Triangular Surfaces

Defines the mesh patterns for degenerate surfaces or solids.

Tri Pattern on Retang 
Surfaces

Defines the mesh patterns for surfaces or solids with 90 degree corners only.

Isomesh Smoothing 
Parameters

Controls how the Isomesher handles transitions between regions with different 
numbers of elements.
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lengths. The mesh seed is represented by small yellow circles displayed only when the Finite Element 
applications form is set to creating a Mesh, or creating or deleting a Mesh Seed.

Direct Finite Element Modeling 
The vast majority of finite element modeling performed today is via operations on geometric modeling, one 
or more pieces of geometry are created, and then a mesh and properties are generated. In other cases, however, 
it may be easier to work directly with the nodes and elements themselves. 
Such cases might include:

Display Existing 
Seeds

Plots all defined mesh seeds associated with the visible geometry

Element Edge Length 
Data

Patran calculates the nonuniform mesh seed node spacing through a geometric 
progression based on the given L2 ⁄L1 ratio.

 Num Elems and 
L2 ⁄L1

Specifies that you will enter an integer value for the desired number of elements 
and an edge length ratio as indicated by the diagram.

 L1 and L2 Specifies that you will enter edge lengths for the end and middle elements.

Curve List Specifies a list of edges by either cursor selecting existing curves or surface or solid 
edges, or specifying curve IDs or surface or solid edge IDs. For example, Curve 10, 
Surface 12.1, Solid 22.5.2.)
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 Modifying a mesh read in from an analysis program, such as an MSC Nastran bulk data file. 
 Finite element models whose meshes are created via an external software application, without an 

underlying geometry model. 
 Changing specific elements that fail verification tests.

It is preferable to mesh a geometric model where possible, from a standpoint of both modeling time and 
assignment of properties. When properties are assigned directly to geometry, the mesh can later be modified 
without needing to re-assign these properties. Conversely, properties assigned directly to nodes and elements 
may need to be re-entered if the underlying mesh is changed.

Direct finite element modeling tools in Patran include the following:

 Create actions that create nodes, elements, MPCs (Multi-Point Constraints), and superelements.
 Transform actions that create nodes and elements via Transform, Rotate and Mirror operations on 

existing nodes and elements.
 Sweep actions that create higher order elements by sweeping lower order elements through a path, as 

described above under 2-1/2D mesh generation.
 Modify actions that smooth an existing mesh, edit element and node ID or attribute values, split 

existing Bar, Quad or Tria elements, or modify MPC attributes.

Checking the Finite Element Model
There is rarely such a thing as a perfect finite element model, beyond trivial cases such as single-element test 
problems. Every finite element model is an approximation to a model's behavior. One of the reasons for this 
is that elements can vary in accuracy depending upon how they are used. In addition, it is important to verify 
the correctness of your finite element model, and test for problems such as duplicate elements or unconnected 
(un- equivalenced) groups of elements.

Patran provides numerous verification capabilities to check the quality of your finite element model. It is a 
good idea to run finite element verification tests on a regular basis, both to check the potential accuracy of 
your model, and to get an idea of the overall quality of your finite element mesh. Several of the tests provided 
are described in the following subsections.

To verify a finite element model:

1. Select the Verify action on the Finite Elements application form.

2. Select the corresponding Object and Method for checking an aspect of your finite element mesh.
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Element Shape Tests
 Aspect measures the maximum dimension ratio of opposing edges, faces or principal directions in 

surface or solid elements. For example, in a Quad element, the aspect ratio represents the ratio of 
length to width. Normally, finite elements provide more accurate answers when the aspect ratio is 
closest to 1. 

 Warp measures the degree to which a Quad element's corner points are out of plane from the 
centroidal plane of the element. 

 Skew measures angular deviation from a rectangular shape in surface elements.
 Taper measures geometric deviation from a rectangular shape in Quad elements.
 Edge Angle measures the maximum deviation angle between adjacent faces of a solid element.
 Face Warp, Face Skew, Face Taper measures warp, skew, and taper, as described above, for faces of a 

solid element.
 Twist measures the maximum twist between opposing solid element faces in Wedge and Hex 

elements.

Other Element Tests
 Boundaries test for free element edges with no adjacent connected element. This is an important test 

to check for unequivalenced portions of your model.
 Duplicates detect multiple elements connected to the same nodes.
 For shell elements, Normals check for consistent normals between adjacent elements. 
 Jacobian Ratio, Jacobian Zero tests based on the maximum variation and minimum value of the 

Jacobian determinants of each element, respectively.
 IDs color code the elements based on their ID numbers. This is a useful test for visual verification of 

element number ranges and order of modeling.

Other checks include midside node offsets for higher order elements, superelement boundaries, and a contour 
line plot based on nodal ID values. 
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For many of these verification tests, you can set a tolerance value to specify the value or percentage that 
elements cannot exceed. Then in most cases, a color-coded element display is produced showing the results 
of the verification test. Elements failing your tolerance are displayed in the highest spectrum color (generally 
red). Other elements are color-coded to spectral values to show how close they are to 
your tolerance. 

The proper settings for this tolerance value become a matter of experience with particular element types. For 
example, a linear triangle element may be very sensitive to distortion, while a quadratic-order triangle element 
may give good results with even a fairly high degree of distortion. While using a conservative value may help 
you improve the quality of your finite element mesh, it may also lead to more human engineering time in 
modifying this mesh for better verification results.

Options When Tests Fail
When elements fail your verification tests, your options include the following:

Remesh the Model
Replacing the existing mesh with a better one is frequently a good way to conserve time, particularly when 
these new meshes do not substantially alter the analysis run time. In a case where some elements have 
excessive aspect ratios, for example, re-meshing with a higher mesh density in the long direction may quickly 
resolve this problem. 

Particularly in cases where you have created a finite element mesh from a geometry model, it is easy and 
straightforward to re-create the meshes for individual regions.

To remesh a model:

1. Delete the original mesh by selecting Delete/Mesh on the Finite Elements application form.

2. Re-create the mesh by selecting from the Create/Mesh family of options described above.
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Repair Individual Elements
For some verification tests involving Quad elements, Patran provides automated features to repair elements 
that are out of tolerance. For example, when Quad elements fail the aspect ratio check, there is an option to 
automatically divide them into smaller elements at their corner points. 

Alternatively, you can directly perform operations to create and modify your finite element model. For a brief 
description on creating your own nodes and elements for a finite element model, see Direct Finite Element 
Modeling. Other options here include selecting the Modify action on the Finite Elements application form, 
which supports operations such as smoothing the mesh, editing element and node data, or splitting existing 
elements into smaller ones.

Check your Tolerance
Patran does not force changes to be made to your model based on the results of verification tests. These results 
are intended as guidelines for you, to help you make better analysis modeling decisions. Therefore, you may 
decide to increase your tolerance value when you are using higher-order elements, or when elements that have 
failed your verification tests are located in less-critical areas of your model.

In general, finite element verification tests should become a routine part of your process of finite element 
modeling. The complexity of many finite element meshes, combined with the limits of visualizing these 
models graphically, means that you cannot always see problems in your model. For example, duplicate 
elements often look identical to single elements, and a badly distorted element may not be visible within a 
dense, complex mesh of a critical region. 

By using Patran's automated verification capabilities and applying your own engineering judgment to the 
results, you add an extra measure of reliability to your analysis work.
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Overview of Materials
In Patran, a material is defined as a named group of material-related properties that are relevant for a 
particular finite element analysis. Material properties tell Patran what your model is made of (steel, a 
composite, etc.) and define the attributes of that material (such as density, stiffness, specific heat, elastic 
modulus, Poisson’s ratio, and so on). Patran provides a materials application form and several subforms that 
allow you to create, modify, show and delete materials. 

Each analysis code supports a different set of materials. The properties you must specify for a material depend 
on several factors: 

 The type of analysis you will run (such as structural or thermal). 
 The analysis code you have selected (such as MSC Nastran).
 Whether you are entering the material property definition yourself, or selecting a definition from an 

external run file.
 Your choice of certain key characteristics (such as material type and one or more constitutive 

models).
 In some cases, the element type to which you will assign the material. 

When you define a material property, it is not yet associated with the finite element model. Only when the 
element property is created, is the material is then associated with the model. It is the element property that 
references both the model and the material. The Element Properties application is described in Element 
Properties. 

After you have defined the materials and assigned them to the model, you can select a viewport display of 
material property sets that includes XY plots of selected properties. You can also view a tabular display of the 
stiffness or compliance matrices that result from the material properties.

Basic Concepts and Definitions
This section describes the different types of material models that Patran supports and the methods by which 
you can input material property data.

Homogenous, Composite, and Constitutive Material Models

Homogenous Material Types
Patran provides five homogeneous material types that you may select as the Object on the Materials 
application form: Isotropic (same properties in all directions), 2D and 3D Orthotropic (properties vary in 
primary directions), and 2D and 3D Anisotropic (properties vary in arbitrary directions). In general the 2D 
material types should only be used by planar elements and the 3D formulations should only be used by solid 
elements. 

Type (Object) Structural Characteristics

Isotropic Same properties in all directions (two elastic constants).

2D Orthotropic Properties vary in primary directions (six elastic constants).
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Composite Material Types
In addition to the homogeneous materials, you may also define composite materials that are based on layering 
homogeneous materials using one of several methods. Composites are the most complex materials; Patran 
provides several subforms and material properties just for composites. The theory and equations that support 
the composite materials implementation in Patran are described in detail in the Patran Reference Manual, 
Volume 3, Part 5: Functional Assignments.

In order to define a composite material, you must define the homogeneous materials that form the layers, the 
thickness of each layer, and the orientation angle of the layers relative to the standard coordinate axis being 
used for the model. The orientation is particularly important for orthotropic and anisotropic materials, whose 
properties vary in different directions.

The following table describes the four supported construction methods for composites. Each method is 
supported with different construction forms within Patran. Some composite forms display a spreadsheet for 
inputting thickness and orientation values, while other forms hold mathematical formulas. Two of the 
composite construction methods can be implemented in more than one way; there are five Halpin-Tsai 
submethods and two Short Fiber submethods.
 

3D Orthotropic Properties vary in primary directions (nine elastic constants).

2D Anisotropic Properties vary in arbitrary directions (six elastic constants).

3D Anisotropic Properties vary in arbitrary directions (21 elastic constants).

Method Variations Algorithm Intended Application

Laminate Includes a choice of stacking 
sequence convention for 
structural analyses.

Classical Lamination 
Theory

Laminated shells and 
solids.

Rule of Mixtures n/a Volume-weighted averaging 3D composites with 
multiple phases, arbitrary 
orientations, and arbitrary 
volume fractions.

Halpin-Tsai 1. Continuous fiber
2. Discontinuous fiber 
3. Continuous ribbon
4. Discont. ribbon 
5. Particulate 

Halpin-Tsai equations 2-phase composites.

Short Fiber 1. 1D composite

2. 2D composite

Monte-Carlo integration 
combined with volume-
weighted averaging

Short fiber composites 
whose orientation 
distribution can be 
described by a Gaussian 
curve or surface.

Type (Object) Structural Characteristics
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Constitutive Models
In a structural analysis, a constitutive model describes the stress-versus-strain behavior of the material 
properties used in a model. Here are a couple of examples of constitutive models:

 Linear elastic: the material deforms proportionally to how much force is applied (linear) and returns 
to its original shape when you remove the load (elastic). In the simplest case, this kind of material 
can be defined by two constants: 

• Young's modulus (or E), which is the ratio between stress and strain.

• Poisson's Ratio, which relates strain in different orthogonal directions (analogous to how much 
peanut butter squirts out the sides of a sandwich when you press the bread slices together).

 Elastoplastic: the stress-versus-strain curve is elastic up to a certain level of stress, and then plastic 
(that is produces permanent deformation) above this. Since you now need more than a constant to 
describe this, it is often defined as points on a stress-strain curve.

You can define multiple constitutive models for a single material (such as elastic, plastic, and creep models). 
For example, a material can have an elastic representation and an inelastic one under the 
same name.

You can configure the models as Active or Inactive prior to starting the analysis job. You can also leave more 
than one model enabled at the same time if needed. Patran attempts to include all Active constitutive models 
when you submit an analysis. For example, to use a simple elastic model for checkruns, set all other 
constitutive models to Inactive. 

Material Property Definitions
After selecting the type of material model that best represents the behavior of a material, you build the 
material model by specifying the appropriate material properties. To manually input material property values, 
you use Patran’s Material Property application forms. 

Material Property Fields
Fields are an Patran feature that allows you to describe how one quantity varies in relation to another quantity. 
You can use the Fields feature for many applications, including defining a variable 
material property.

Materials can be defined to vary as a function of temperature, strain, strain rate, time and/or frequency, using 
a material property field. You can define a material property field by entering tabular data in the Fields top 
menu selection. An example would be the dependence of an elastic modulus on temperature. 

You can create Material Property Fields that define distributions of any property with respect to any 
combination of temperature, strain, or strain rate. Materials remain in the database unless specifically deleted 
and thus provide an archival record. Use the Show action on the Materials form to display properties versus 
temperature, strain, and strain rate in either tabular form or as XY plots. You can also show the resultant 
stiffness and compliance matrices.



127Chapter 6: Material Modeling
Creating Material Property Models
Creating Material Property Models
A material model is a group of material properties that describe what your model is made of (such as steel or 
a composite) and the attributes of that material (stiffness, density, and so on). Once the materials for your 
model are defined, you will use the Element Properties application to assign them to model regions.

The Materials Application Form
The Materials application is where you define the materials for your analysis model. Patran provides options 
for creating and modifying an enormous number of material models. The Input Options subform is where 
you specify most of the material properties information. There are many Constitutive Models and material 
property value options available. The input options that appear and the values that you select for them 
depend on factors such as your analysis code and solution type equations.

To use the Materials Application form:

1. Click the Materials button on the Patran Main form.

The Materials application form appears in your viewport.

2. Select an Action, Object, and Method from the drop-down menus at the top of the form.

The bottom portion of the form varies depending on your selections for action, object, and method.

Actions
Use actions to create, show, modify, and delete material models.  Action describes the action choices on the 
Materials Application form.
 

Action Descriptions

Create  Input analysis code-specific material property data and associate that data with 
selected FEM or geometric entities.

Modify Make any change desired to Existing Materials Property Data.
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Objects
The objects are the types of material models that you have available.  The following table summarizes the 
object chioces.
 

Methods
The Method defines how you create a material model. You may start your model in one of two ways: 

 Manual Input on the Input Options subform. An existing material may be used as a template to 
create a new material.

 Externally Defined, to define and assign materials in name only. This permits property data to be 
included in run files external to Patran.

The Methods table briefly describes the methods you may select.
 

Sample Materials Forms
The following is a sample of a manual input of isotropic material properties.

Sample Manual Input Form
A sample Materials form is shown, for the selection Create/Isotropic/Manual Input. The selected Analysis 
Code and Type are MSC Nastran /Structural. Once you have selected the Input Properties button located at 
the bottom of the Materials application form, a separate Input Options subform appears in the viewport. 
Every time you pres the Apply button a new constitutive material model is created based on the setting in the 
Input Options form.

Delete Remove material property sets from the database.

Show Display tables listing material properties.

Object Descriptions

Isotropic Use for materials whose properties are the same in all directions.

2D Orthotropic Use for materials whose properties vary in orthogonal directions.

3D Orthotropic Use for materials whose properties vary in orthogonal directions.

2D Anisotropic Use for materials that vary in arbitrary directions.

3D Anisotropic Use for materials that vary in arbitrary directions.

Composite Layered materials with or without varying directional properties.

Method Descriptions

Manual Input The Input Options form is used to input material property data. The data required 
varies depending on the analysis code, solution type, and constitutive model.

Externally Defined The material is defined in an external file.The Input Options form is not required.

Action Descriptions
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A description of the data widgets on this form follows.

Existing Materials Chooses a material from here to transfer it to the Material Name text box.

Material Name Defines a unique name (1-31 characters) for the material and automatically 
assigns a sequential Material ID number.

Description User-supplied descriptions of a selected material are displayed here for 
reference (1-256 characters). By default, the time and date of creation 
appears.

Preference and Type The Analysis Preference and Type appear. Check for correctness.



Patran User’s Guide
Creating Material Property Models

130
Sample Input Options Subform
Once you select Manual Input as the Method on the Materials application form, you must select and fill out 
the Input Options form for the material. Most of the Input Options forms are similar to the one shown below. 
There is a Constitutive Model plus other option selections, followed by databoxes to input specific property 
parameters. When you can use fields, a list of available Material Property Fields appears.

Input Properties Brings up the Input Properties form to input values for properties of this 
material.

Change Material Status Brings up the Change Material Status form to enable and disable material 
model definitions.

Constitutive Model Selects a Constitutive Model from the unfold box. A single material may 
have several active constitutive models.

Material Property Values Input the values necessary to define the material model. This is just an 
example; the actual form displayed depends on the analysis code and type.

Current Constitutive 
Models

The existing constitutive models and their status (i.e., active or inactive) 
appear here. Once you complete this form and select Apply, the newly 
created set appears here.
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Sample Constitutive Model Status form
A single Material can have several Constitutive Models defined, such as an elastic representation and an 
inelastic one. The constitutive model used in the analysis is determined by the Constitutive Model Status.

Existing constitutive models of an existing material appear in either the Active or Inactive list box depending 
on their current status. Selecting a model in either listbox automatically moves it to the other one.

Checking the Material Model
Whether you have manually input your material properties for your model or have imported materials 
properties from an external source, you may want to verify the final material model before proceeding to the 
next step. Using the verification capabilities in Patran, you can look at the material properties, the generated 
stiffness matrix, and the generated compliance matrix.

To check a material model:

1. Access the display properties capability by selecting the Show action on the Materials application 
form.

Note:  To define more than one constitutive model for a material, fill out the form more than once, 
pressing Apply each time.
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2. With the Method set to Tabular, select one of your material models from the Existing Materials 
listbox.

3. Select either Show Material Stiffness or Show Material Compliance to display the stiffness or 
compliance matrix.
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Overview of Forces and Loads
Most analysis problems involve the solution of how a model behaves in response to some action on this 
model--a force, a pressure, a temperature, or perhaps a magnetic field. In analysis terminology these actions 
are known as loads. Similarly, most models have certain conditions constraining their behavior. For example, 
an end of a cantilever beam fixed to a wall, or an adiabatic (non-conducting) boundary in a thermal problem. 
These constraints are referred to as boundary conditions. In this chapter loads and boundary conditions are 
frequently referred to as LBCs.

Figure 7-1  Model with point load and displacement boundary conditions

There is a great deal of similarity in both of these quantities. Both are applied to portions of your model, and 
some quantities may in fact be used as both loads and boundary conditions. For example, a fixed zero 
displacement in a structural model serves as a boundary condition, while an imposed non-zero displacement 
also has the effect of acting as a load. Hence, a common set of operations is used within Patran to create both 
loads and boundary conditions. 

The specific loads and boundary conditions available to you depend upon the analysis program you are using 
with Patran. Both load and boundary conditions can be applied to either your geometric model or your finite 
element model. Both quantities have the important feature of being independent of the finite element model 
itself. A single analysis model may have many different states of loads and boundary conditions, or a series of 
loads applied at different times or frequency values in an analysis. This flexibility allows you to ask many 
different kinds of "what if?" questions using the same finite element model, and to simulate many kinds of 
complex behavior.
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The Fields and Load Cases Applications
The Fields and Load Cases applications are used together with the Loads and Boundary Conditions 
application. The figure below shows the relationships between these three applications.

Figure 7-2  Three LBCs-related applications

In addition to loads and boundary conditions, which remain constant over a period of time and over a 
particular region of the model to which they are applied, you can also define varying loads and boundary 
conditions. LBCs that vary temporally or spatially are defined using the Fields application. This application 
is described in detail later in this chapter. 

In Patran, different individual sets of loads and boundary conditions are grouped into quantities known as 
load cases, which essentially constitute a separate analysis solution using the same model data. We will discuss 
load case capabilities in Patran later in this section.

Basic Concepts and Definitions
Following are several basic concepts and definitions that provide important information about the Loads and 
Boundary Conditions application.

Analysis Types and LBCs
In Patran, loads and boundary conditions are treated as a single type of data to be assigned to portions of your 
geometry or finite element model. As mentioned above, the specific load and boundary condition data which 
you can assign is highly analysis-dependent. The analysis preference which you set upon entry to your 
database, or define later via the Preferences/Analysis menu option, determines which options are available to 
you when you use the Loads/BCs application form in Patran. 

As a result, the kinds of load and boundary condition data which you can specify may vary from the examples 
shown in this guide, which use preferences available for MSC Nastran. Nonetheless, there are several basic 
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kinds of loads and boundary conditions which are common to many of the most popular finite element 
analysis programs available today. The following subsections describe some of the more general types you may 
encounter. 

Beyond the three basic kinds of analyses described below, there are many additional analysis types, including 
acoustic, electromagnetic, and frequency response, to name a few. Each of these kinds of analysis has its own 
unique loads and boundary conditions, based upon the capabilities of the analysis software you are using in 
tandem with Patran. The actual loads and boundary conditions that you will use depend a great deal upon 
the behavior you are trying to simulate and the engineering assumptions that you make in your model.

Structural Loads and Boundary Conditions
In a structural analysis problem, you are generally trying to determine the response of a model to physical 
loading, or specific structural behavior such as frequency response or buckling. Some of the loads and 
boundary conditions you may work with include force, pressure, velocity, inertial loads, displacement, 
temperature, and contact. 

Thermal Loads and Boundary Conditions
Thermal analysis problems, which determine the response of a model and its materials to thermal conditions, 
include loads and boundary conditions such as heat sources, heat flux, convection, radiation emissivity, and 
view factor. Note that the temperature values that often form the output of a thermal analysis may 
subsequently be used themselves as loads in other types of analyses, such as structural problems. The use of 
output quantities as loads is supported in Patran using a field capability known as FEM fields, discussed later 
in this chapter.

Fluid Dynamics Loads and Boundary Conditions
Fluid dynamics analyses simulate the behavior of fluid flow, and feature inputs such as velocity fields, 
pressures, and temperature. 

Load Cases 
Load cases contain loads and boundary conditions used within a single analysis solution. For example, one 
load case may represent the loads and BC for each time point in a time-dependent analysis, or a single state 
of loading for one of many static problems. They are central to the ability to perform complex analyses on an 
individual model, or examine multiple states of loading and behavior within the 
same model. 

There is a default load case that, in the absence of specifying your own load cases, contains any loads or 
boundary conditions defined for your model. For basic single-state problems, such as static structural or 
steady state thermal analysis, this default load case is often sufficient. For more complex analyses, or for 
multiple cases of simpler behavior within an analysis, specific load cases must be defined.
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Fields 
One of the most elegant features in Patran is its ability to create fields that describes the variation of the values 
of an analysis quantity, including loads and boundary condition objects, material properties, and element 
properties. 

Once you have defined a set of fields, you can easily select them as values on the Input Data subform for the 
Loads and Boundary Conditions application, instead of entering a constant. Moreover, Patran presents a list 
of the fields that are available whenever you click in an appropriate databox. Following are descriptions of the 
four main types of fields:

 Spatial Fields. This most common type of field describes quantities that vary spatially over the 
model, such as a linearly varying heat source, a quadratic distribution of pressure across a boundary, 
or a discrete set of material properties. These fields are defined using spatial equations, or via tabular 
specification. 

 FEM Fields. These fields are based on previous analysis results. A good example of this is taking the 
results from a thermal analysis and using them to define a temperature load for a structural analysis 
of the same model. To create an FEM field, you generate a graphics display of the desired results, 
then place the quantities used to produce the display in a field. 

 Time-dependent Fields. For analysis codes that support time-dependent problems, the Loads and 
Boundary Conditions application applies time-dependent and frequency-dependent loads over the 
time steps of a time-dependent analysis, using either equations or tabular input to define the 
variation. They are placed within a time-dependent load case, as described in a subsequent section of 
this chapter. 

 Material-dependent Fields. Materials property fields can be created that vary based upon a 
dependent variable such as temperature or frequency. These capabilities are described more fully in 
Element Properties. 

Applying Loads and Boundary Conditions
Within Patran, the LBC-related information is stored in loads and boundary conditions sets. For each LBC 
set, you must define a unique name, an analysis type (Structural, Thermal, etc.), and one load or boundary 
condition object set type (such as pressure, displacement, heat, or inflow). The LBC sets are either static or 
dynamic. You can apply these sets to geometric entities or FEM entities, as defined in the Select Application 
Region subform.

The Load Cases and Fields applications are helper applications used with the LBCs application. The Load 
Cases application (p. 146) is provided so that you can separate numerous loads and boundary conditions sets 
into groups. If you do not create any load cases, all LBC sets are added to a load case, named “default.” To 
create loads and boundary conditions that vary temporally or spatially, you will need to use the Fields 
application (p. 149). First you create the field that describes the variation, then reference it when you create 
the LBC.
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The LBCs Application Form
The LBCs Application is where you define the load and boundary condition sets for your model. 
Using the application form you can create, modify, delete, and show a range of load and boundary condition 
data.

To use the Load and Boundary Conditions Application form:

1. Select Loads/BCs from the Patran Main form.

The Loads/Boundary Conditions application form appears.

2. Choose an action, object, and type combination from the pop-up menus.

The remainder of the form varies depending on your selections for these three fields.

Actions
The following table  briefly describes the Action choices on the Loads and Boundary Conditions form.
 

Objects
The table below lists the LBC objects that are supported for each analysis type. The LBC objects (also called 
Set Types) that you may assign vary depending on what analysis code you have selected; the table shown is 
mostly based on the MSC Nastran analysis code. 

Action Descriptions

Create Creates a new set using structural, thermal, or fluid dynamic analysis set type 
options.

Modify Changes any property or characteristic of a set.

Delete Removes selected sets from the database.

Show Tabular Displays set data in a table format.

Plot Contours Displays contour plots of selected set data on the model.

Plot Markers You can selectively turn Marker display for each Loads/BCs set type ON and 
OFF from this form. When you create loads and boundary conditions for a 
region of your model, they automatically display with markers. The markers 
may be arrows, circles, squares, etc. 
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Analysis Type LBC Object (Set Type)

Structural Displacement, Force, Pressure, Temperature, Inertial Load, Initial 
Displacement, Initial Velocity, Velocity, Acceleration, plus others depending 
on the Analysis code.

Thermal Temperature, Convection, Heat Flux, Heat Source, Initial Temperature, and 
others depending on the Analysis code.

etc. Other analysis types may be available depending on the Analysis code 
selected.
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Types
The selection for Type defines whether the created load sets are associated with the elements or with the 
nodes. The table that follows summarizes the available Types of LBCs. 

Sample LBCs Forms
The following sample form creates a displacement boundary conditions set named Disp1. 

Sample Loads/BCs Input Form
After selecting the Action/Object/Type combination, the application form prompts you to specify several 
additional fields, as shown below.

LBC Type Descriptions

Nodal Loads and boundary conditions that you generate will be ultimately 
associated with the nodes in your finite element model. For example, if you 
define a displacement boundary condition over a region in your geometry 
model, Patran ultimately generates a boundary condition at each node in 
that geometrical region.

Element Uniform Loads and boundary conditions that you generate are ultimately associated 
with the element s in your finite element model. The LBCs are uniform 
across the element.

Element Variable Loads and boundary conditions that you generate are ultimately associated 
with the elements in your finite element model. LBCs vary over each 
element.
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A description of applicable widgets on this form follows.

Widgets 

Current Load Case Initially the set is named Default. Click to make a new selection in the form 
that appears. Time-dependent sets require a time-dependent load case.

Existing Sets The names of all sets for the selected object are displayed here. Selecting one 
retrieves it from the database. 

New Set Name Each new set requires a unique name (31 characters maximum, no spaces). 
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Input Data Displays a form to specify appropriate variables for the set type selected.

Select Application 
Region

Displays a form to select entities to which this set applies. Standard selection 
methods are used.
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Sample Input Data Subform
Selecting the Input Data unfold box on the application form brings up the Input Data subform shown below. 
Use this form to specify the displacement data for boundary conditions.

Widgets 
 

Load/BC Set Scale Factor All loads and boundary conditions data variables are multiplied by this Scale 
Factor. The default value is 1.0.

Translations/Rotations Enter data values to define translational and rotational movement.
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Sample Select Application Region Subform
Selecting the Select Application Region unfold box brings up the Select Application Region subform. Use 
this form to define the portion of the model you want to apply the displacement boundary condition.

Widgets 

Defining Load Cases 
The Load Cases application enables you to combine a large number of individual loads and boundary 
condition (LBCs) sets into a single coherent case for application to the model. Each load case you create has 
a unique user-selected descriptive name as well as an associated descriptive statement. Load case information 
is permanently stored in the database (unless deleted). You can modify it at any time.

The Load Cases Application Form
Even if you do not create any load cases, your load and boundary conditions will still be placed into a default 
current load case, named “default.” If you create a special load case and make it the current load case, then all 
subsequent LBCs will be placed in that load case as long as it is current. Load cases in which none of the 
constituent loads or boundary conditions sets has a time varying component are called static load cases. Load 
cases in which one or more of the loads and boundary conditions sets has a time varying component are called 
time-dependent, or dynamic load cases.

Application Region Specify the geometric regions by cursor selecting them or by entering IDs.
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To use the Load Case Application form:

1. Select Load Cases from the Patran Main form.

The Load Cases application form appears in your viewport.

2. Select an Action from the top of the application form.

Note that only the Action option is available on this application form. The rest of the form varies 
depending on the action you select.

A list of Action follows.

Actions
You may select the following actions on the Load Cases form: Create, Modify, Delete, Show, and 
Assign/Prioritize.
 

Action Descriptions 

Create Create new load cases either from scratch or by modifying existing load cases.

Modify Modify existing load cases to change the name, type, description, and the 
Loads/BCs sets included. You can also change the definition of the current 
load case.

Delete Delete load cases from the database; you may also delete Loads/BCs sets 
associated with deleted load cases if desired.

Show Show information about all the load cases in the database. For each load case, 
display the name, type, description, and list the constituent Loads/BCs sets. 
Indicate which load case is the current one.

Assign/Prioritize 
Load/BCs

Assign particular Loads/BCs sets to a load case. Resolves potential conflicts 
between Loads/BCs set types within a given load case. Assigns scale factors to 
the load case and to the Loads/BCs sets in the load case.
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Sample Load Cases Form
The following form shows the Create action, that creates new load cases, either from scratch or by 
modification of existing load cases. Each new load case is given a unique name, type (static or time-
dependent), and description. You can also assign loads and boundary conditions sets to it. You can set the 
new load case as the current load case, if desired. All new LBCs that you create are placed in the current load 
case.
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Widgets 
 

Using Fields
In some analysis models, particular input options for element properties, material properties, or loads and 
boundary conditions are not constant; they vary as a function of spatial, time, temperature, and other 
changes. Fields are used in these situations. Examples are a shell element whose thickness varies spatially, a 
pressure pulse load that is time-dependent, and a material property that is temperature- or stress-dependent. 

The Fields Application Form
The structure of fields is flexible and generalized. You can create them from tabular input, mathematical 
relationships expressed in PCL, or from scalar/vector results on a collection of finite elements. The Fields 
application in Patran provides intuitive forms that lead you through the creation and modification of fields. 
Once you have created the field that you need, select it in a databox on one of the functional assignment 
application forms or input options forms.

To use the Fields Application form:

1. Select Fields from the Patran Main form.

The Fields application form appears in your viewport.

2. From the drop-down menus, select an Action, Object, and Method.

The remainder of the form varies depending on these selections.

Filter Limit the display of existing load cases by specifying a filter requirement for 
the load case name of one or more characters. 

Existing Load Cases All load cases in the database appear in this table. You may wish to select a case 
to modify into a new case. 

Load Case Name The name of a selected case (if any) appears here. 

Make Current Toggles this button ON to make the current load case.

Load Case Type Selects the load case type (static or time-dependent).

Description Inputs a load case description (up to 256 characters). It is important to do it 
now to have a listing later.

Assign/Prioritize 
Load/BCs

Assigns Load/BCs sets to the Load Case. Modifies the default priority. The 
default priority is Add (i.e., if a conflict arises then add Load/BCs values 
together). Sets scale factors for the Load Case and Load/BCs sets in the Load 
Case.
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Actions
The table below briefly describes the choices for Action on the Fields form.
 

Objects
The table below briefly describes three types of fields that you can select as Objects on the Fields application 
form.
 

Action Descriptions

Create Creates a new field that can be Spatial, Material Property, or Non-Spatial. You 
can base the new field on an existing field. Most fields are made up of tabular 
data or PCL functions.

Show Displays all fields set data in a table format.

Modify Modifies the contents of an existing field.

Delete Removes selected fields. 

Field Type Description

Spatial Spatial fields define location-dependent pressures and temperatures in the 
LBCs application. You can also use them to define element property 
characteristics, such as thickness. They also define displacements and other 
loads. Spatial fields can be scalar or vector in nature. You can specify their 
application region in either real or parametric space, over one, two or three 
dimensions. You can apply multiple spatial fields at the same time.



151Chapter 7: Loads and Boundary Conditions
Using Fields
Non-Spatial Non-Spatial Fields specify time- and frequency-dependent loads and 
boundary conditions, and frequency-dependent material properties.

Material
Property 

Select these fields on the Input Options form for the Materials application for 
properties such as modulus, CTE, etc. These fields can be one-, two-, or three-
dimensional, with independent variables such as temperature, strain, strain 
rate, time, and frequency (singly or in combination). 
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Methods
The following table briefly describes the method of data input that you may select as Method on the Fields 
application form. 

Field Type Description

PCL Function Uses a PCL expression to define the field values.

Tabular Input Extracts data from a table to define the field values.

General Field You can use the General Field to create a field for any Object type. The field 
data is described by a mathematical function composed in PCL.

FEM FEM Fields are associated to a finite element model. Using this method you 
can map data from one analysis to create LBCs for your current model.
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Sample Fields Form
The form for Create/Spatial/PCL Function creates scalar or vector spatial fields in real or parametric space, 
using a PCL expression or externally defined PCL function. Select Apply to create the field, then wait for the 
new field name to appear in the Existing Fields databox.

A list of widget descriptions follows.
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Widgets 

Verifying Your LBC Model
Errors in loads and boundary conditions represent one of the more subtle errors that can take place in an 
analysis model, as well as one of the more potentially serious ones. For example, a set of load symbols on a 
model may look the same with ten times the intended value, but will cause a dramatic difference in the 
analysis result. Similarly, a boundary condition applied to a sparse number of finite elements may appear to 
be the same as one applied to an entire edge of a geometric model. This makes it critical to verify your loads 
and boundary conditions prior to analysis.

There are two primary ways to verify the load and boundary conditions that you have applied to 
your model:

 Visual inspection, using graphics displays to examine the placement of load and BC data on 
your model. 

 Numerical verification, where you examine the actual values used for loads and boundary conditions 
in tabular or report form.

As discussed earlier, the Loads/BCs menu provides two primary ways of displaying LBC data graphically on 
your model: Plot Markers and Plot Contours. The first of these techniques, Plot Markers, comes 
automatically with most cases of modeling loads and boundary conditions. 

Plot Markers
Whenever you create or modify LBCs data, visual markers display on your model by default. These symbols 
are coded by color and shape to correspond to your specific Loads/BCs, with some examples shown here.

Existing Fields Previously defined fields appear here. Select one with the Create Action if you 
wish to base a new field on an existing field. Select with Modify to change an 
existing field. The selected field name appears in the Field Name box below.

Field Name Modify an existing field name, or enter a new field name here.

Field Type Select Scalar or Vector. The form changes, depending on the pick.

Coordinate System Type Select Real if the field is in X,Y,Z space, Parametric if it is in C1, C2, C3 space.

Scalar Function  Input a PCL command defining the field or name of the external PCL 
function file. 
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Figure 7-3  Examples of Plot Markers for LBCs

These displays become a permanent part of your display until they are explicitly cleared. The Display --
>Loads/BCs/El.Props menu can be used to manage turn on, turn off, change the colors or manage the display 
of these symbols.
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Figure 7-4  Display menu for Loads/BCs/El.Props

In addition, you can enable the Show on FEM Only toggle to display LBCs data on the finite elements 
themselves, even if they had been originally applied to geometric entities. This can represent an important 
additional form of display verification, because symbols displayed on geometry are only shown along the 
visualization lines defined in the Display /Geometry menu. 

The Show on FEM Only toggle causes these symbols to be displayed at each node or element of the finite 
element model, which more accurately displays how the analysis program will see these loads and boundary 
conditions.
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Plot Contours
For scalar values, an alternative form of display is to use the Plot Contours action to display a color fringe 
display of the load data on the surface of the model. These scalar values can either be direct scalar quantities, 
such as temperature, or a scalar component of a vector quantity, such as the X-component of an applied force.

To plot contours:

1. On the Loads/BC Application form, set the Action to Plot Contours.

2. From the Object drop-down menu, select the load/boundary condition you wish to plot.

The spectrum values and color coding for these contour displays will span the range of values by default, but 
can be modified using the Display --> Spectrums menu. When you no longer wish to display this contour 
plot, select the Reset Graphics button on the Plot Contours menu form. 
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Show Load/BC Data in Table Format
To verify your load and BC values numerically, you can use the Show Tabular action of the Loads/BCs 
application form to create a spreadsheet-like display of data for the current load case.

Figure 7-5  Numerical display of LBCs data from Show Tabular action 

These display and verification capabilities all pertain to the current load case. To look at results from other 
load cases, make these load cases current using the Loads/BCs or Load Cases applications forms.

An even more important form of verification has nothing to do with software at all; that is to critically 
evaluate your analysis results with an eye towards what you would expect in the physical world.

 When an analysis result seems dramatically more or less than you would expect in an actual model, the first 
place where you should look for a discrepancy is in the values of your loads and boundary conditions. 
Together with checking other values such as material and element properties, proper verification of load and 
boundary condition values helps create an extra margin of confidence in the accuracy of your analysis 
simulation. 

A Case Study of a Coffee Cup
In addition to creating a new geometry model or importing a CAD model, you can also use Patran to 
reconstruct an analysis model. To reconstruct a model, you import an existing FEM model from a valid 
source, such as a Patran database or a MSC Nastran input file. 

Reconstructing an analysis model can substantially enhance the your ability to visualize the text input file, 
and to validate the accuracy and adequacy of the mathematical model. If necessary, you can easily modify 
essential model definitions, such as material specifications, element properties, or load and boundary 
conditions. All of these changes can be made through the Patran graphical user interface without intimate 
knowledge of the analysis solvers.

Problem Description
In this example we will attempt to re-analyze a coffee cup by assuming that the cup is now filled with mercury 
rather than coffee. We will adjust the load scale factor to 13.51 to account for the difference in density. Since 
gravity and cup dimensions do not change, the quickest method to update the pressure load is to increase the 
scale factor of the pressure acting on the cup.
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Analysis Procedure

Setup the Analysis Project 

Creating a New Database

 On the Patran Main Menu, select File >> New. The New Database form appears.
 Enter the name cup in the Filename textbox.
 Click OK. The New Model Preference form appears next. This form allows you to specify the 

generic analysis parameters for the model.
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Selecting Analysis Parameters

 Set the Tolerance to Default.

 Choose MSC Nastran from the Analysis Code pull-down menu.
 Choose Structural from the Analysis Type pull-down menu and click OK.

Import the Geometry 

Importing the Analysis Model

 On the Patran Main Menu, select File >> Import. 
 The Import form appears.

 On the Import form, select Source >> MSC Nastran Input.
 Type the name cup in the filename textbox and click Apply. 
 Use Fit view and change to Iso3 View.
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Plot the Loads and Boundary Conditions (LBC)

Plot the Boundary Conditions Applied to the Cup

 On the Patran Main Menu, click on the Loads/BCs Application button.
 On the top of the Loads/BCs form, select Action >> Plot Marker.
 Under Current Load Case, click on Default, and set the existing load cases from Default to 

Default.SC1.
 In the Assigned Load/BC Sets listbox, select every load/bc set that has Displ in front of its name, and 

highlight default_group from the Select Groups listbox. 
 This selects all the displacements applied to the model.
 Click Apply.
 This plots the selected Load/BC sets.
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 Plot the Existing Pressure Applied to the Cup
 On the top of the Loads/BCs form, select Action >> Plot Contour, and Object >> Pressure.
 Under Current Load Case, make sure the existing load cases is Default.SC1.
 Select pload4.1.2D in the Existing Sets listbox and Top Surf Pressure in the Select Data Variable 

listbox.
 Select default_group in the Select Groups listbox and click Apply.
 This plots the pressure load.

Assign a New Pressure Load to the Model
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Increase the Pressure Applied to the Cup

 On the Patran Main Menu, click on the Loads/BCs Application button.
 On the top of the Loads/BCs form, select Action >> Modify, Object >> Pressure, Type >> Element 

Variable. 
 In the Select Sets to Modify listbox, select the load/bc set that is called pload4.1.2D, and click on 

Modify Data button.
 On the top of the Modify Data form, change the Load/BC Set Scale Factor to 13.51. Click OK and 

then click Apply on the Loads/BCs form.
 The scale factor is due to the difference in density of mercury and coffee. The PCL function that was 

used to assign the pressure is based on the equation “ρgh”, and since gravity and height do not 
change in this case, the quickest method to update the pressure load is to increase the scale factor of 
the pressure acting on the cup.
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Create MSC Nastran Input File 

Create the MSC Nastran Input (Bulk Data) File

 On the Patran Main Menu, click on the Analysis Application button.
 On the top of the Analysis form, select Action >> Analyze, Object >> Entire Model, Method >> Full 

Run.
 Click on the Solution Type button.
 On the Solution Type form, select Linear Static. Click OK.
 On the Subcase form, select Default.SC1 from the Subcase For Solution Sequence listbox. Click on 

the Default in the Subcase Selected listbox to delete the default load case. Click OK.
 Click Apply on the Analysis form.
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 The analysis will take a few seconds before finishing. A file by the name cup.bdf is created and 
submitted to MSC Nastran. This assumes proper configuration of the P3_TRANS.INI file 
(Windows) or the site_setup file (Unix), which point Patran to the proper location of the MSC 
Nastran executable.

Retrieve the Analysis Results 

Translate the Results into Patran for Results Postprocessing

 On the Patran Main Menu, click on the Analysis Application button.
 On the top of the Analysis form, select Action >> Attach XDB, Object >> Result Entities, Method 

>> Local.
 Click on the Select Results File button.
 On the Select File form, select cup.xdb. Click OK.
 Click Apply on the Analysis form.
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Results Postprocessing 
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Create Fringe and Deformation Plot

 On the Patran Main Menu, click on the Results Application button.
 On the top of the Result form, select Action >> Create, Object >> Quick Plot. 
 Click the Select Results icon near the top of the form.
 In the Select Result Cases listbox, select SC1:Default.SC1, A1 Static Subcase.
 In the Select Fringe Result listbox, select Stress Tensor.
 In the Select Deformation Result listbox, select Displacement, Translational.
 Click Apply
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Overview of Element Properties
You can use the Element Properties application to create, modify, delete, and show sets of properties 
associated with particular finite element types, and to assign these property sets to Geometry or FEM entities 
in your model. Some element types are a shell, beam, rod, and spring. Examples of element properties are the 
thickness of a shell, the spring constant for a spring, or an area for a bar element. Materials are element 
properties, and they are assigned to the model via element property set assignment.

The arrangement of element property options is unique for each analysis code and type. You will need to refer 
to your analysis code documentation for complete information about the supported options. Combinations 
of element property options are often given special element names within a particular analysis code 
implementation. For example, a commonly used element in MSC Nastran is the Standard Homogeneous 
Plate.This element results from choosing a combination of 2D, Shell, standard and homogeneous options, 
and quad4 topology on the Element Properties form. 

Basic Concepts and Definitions
This section describes several important concepts and functions that are related to the Patran Element 
Properties application.

Element Types 
Element types help to define the physical characteristics of the model. The table below lists the supported 
element types for MSC Nastran structural analyses (the options for element types are analysis code-specific 
and analysis type-specific). You will notice in looking at the table that a 2D plane element can be a shell, 
bending panel, 2D-solid, membrane, or shear panel. All of these element types can be constructed with the 
same element topology choices (quad or tria shapes, with varying node configurations), but they take on the 
attributes of the element type when the element property is applied .

The attributes of the different element types are an important topic in engineering, and it is beyond the scope 
of this guide to describe the attributes of a shell versus a bending panel, and so on. They are differentiated by 
characteristics such as how the structure is likely to behave given particular load conditions; for example, 
whether stress and strain on the structure will remain within a plane, and what the degrees of freedom are for 
movement of the structure. 

Dimension Type

0D (point) Mass, Grounded Spring, Grounded Damper

1D (line) Beam, Rod, Spring, Damper, Gap, 1D Mass

2D (plane) Shell, Bending Panel, 2D-Solid, Membrane, Shear Panel

3D (volume) Solid
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Beam Modeling and the Beam Library
Modeling structures composed of beams can be more complicated than modeling shell, plate, or solid 
structures. First, it is necessary to define bending, extensional, and torsional stiffness that may be complex 
functions of the beam cross sectional dimensions. Then it is necessary to define the orientation of this cross 
section in space. Finally, if the centroid of the cross section is offset from the two finite element nodes defining 
the beam element, these offsets must be explicitly defined. Fortunately, Patran provides a number of tools to 
simplify these aspects of modeling.

To make the task of modeling beam elements easier, the MSC Nastran analysis code provides a special beam 
library that adds extensions to the basic Patran element property modeling forms. The Beam Library forms 
are a much more convenient way of defining properties for standard beam cross sections. They include special 
functions for I-beams, Tubings, tube beams, and more.

Element Combinations
The Element Properties form allows you to choose many combinations of Dimension, Type, Options, and 
Topology. The table below lists many of the possible combinations of options for two-dimensional elements 
in MSC Nastran. 

Particular combinations of element property options are given special names. A commonly used element in 
MSC Nastran is the Standard Homogeneous Plate. This element results from choosing a combination of 2D, 
Shell, standard, homogeneous, and quad4 topology on the Element Properties form. 

Dimension Type Option 1 Option 2 Topology

2D Shell  Homogeneous  Standard, Revised, 
P-element

Quad and Tria, 
with varying node 
configurations 

 Laminate  Standard, Revised

 Equivalent Section  Standard, Revised, 
P-element

Bending Panel  Standard, Revised, P-
element

Quad and Tria, 
with varying node 
configurations 

2D-Solid  Axisymmetric

 Plane Strain

 Standard, Revised

Quad and Tria, 
with varying node 
configurations 

Membrane  Standard, Revised Quad and Tria, 
with varying node 
configurations 

Shear Panel Quad and Tria, 
with varying node 
configurations 
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Assigning Element Property Sets to the Model
To assign the element property sets you have defined to the analysis model, you must specify an Application 
Region on the Element Properties form. You can specify the Application Region as a collection of one or more 
FEM or geometric entities. You can either type the entity names, or select them in the modeling viewport. 

Properties associated with geometry will be re-applied to the model after remeshing. Properties associated 
with FEM entities have to be recreated if the model is remeshed.

Effect of Changing Analysis Code or Type
All the Element Property sets you create are associated with an analysis code and type, selected using the 
Preferences/Analysis menu or the New Model Database form. If you change the analysis code or type 
preference, the existing element property sets are modified to use the closest matching element type in the 
new preference environment. All applicable property data is automatically transferred.

Changing back to the original analysis code will not necessarily restore the element property definitions to 
their original state if there is no direct mapping. To run the same problem on different codes while 
maintaining the original state of the element property definitions, copy the database, change the analysis 
preference, and then make the appropriate changes to element properties, materials, loads, etc.

Element Property Types, Names, and Numbers
A property is any information required to define FEM element properties, as required by an analysis code. 
These include thickness, spring constants, areas, degrees-of-freedom, offsets, directions, masses, material 
names, etc. Each property is of a specific type. There are nine different property types: Integer, Real Scalar, 
Real Scalar List, Vector, Material Name, Character String, Node, Coordinate Frame, and Nodal Field Name. 
Every Property is classified as one of these types.

Each element property set has an associated name and number. You provide the set names, which may be 
from one to 31 characters. The numbers are assigned in sequence by Patran. The only place you will see 
numbers displayed is in the Show/Marker Plot option.

Element Property Fields 
A Field is a scalar or vector quantity that is a function of up to three independent variables. A field name is 
prefixed by f: and can be defined by a table or PCL expression. An example would be the thickness 
distribution of a shell. Within the Element Properties application, fields usually define property distributions 
that vary spatially. 

Viewing Element Property Sets
The Element Properties application Show action allows you to select marker plots, scalar plots, and tabular 
plots for viewing the element property sets that have been assigned to regions of your model. 
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Show/Marker Plot
Select this action to view markers, graphic symbols that provide visual feedback about the location, 
magnitude, and direction of displayed element properties. To remove them from the screen, turn off the 
General Marker display in the Display/Functional Assignments menu, or click on the Broom icon to clear 
the display.

Show/Scalar Plot
Select this action to view specified element properties in your model using a fringe plot. To remove the plot 
from the screen, select the Display/Entity Types menu and change the Render Style to Wireframe or click on 
the Broom icon to clear the display. For display purposes, data is treated as results, with full user control over 
the spectrum, method, shading, etc. Data display is scalar, of course, but the data can be any nonvector 
element property.

Show/Tabular Plot
Another way to view element properties in your model is to display a table which lists all elements with the 
selected property in the current viewport or all viewports in sequence along with the associated Set Name(s), 
Property Type, and Value.

Creating Element Properties
Through the Element Properties application, you define element types (such as beam, shell, and so on) and 
element-related properties for regions of your model, then assign these definitions to geometric or FEM 
entities. Element type selection is based on the dimensions of the model and your assumptions about the 
model’s behavior. Additional properties describe attributes such as the thickness of a plate, the spring constant 
for a spring, an area for a bar element, materials, and so on. 

The Element Properties Application Form
Element properties are grouped in sets. Each set has a unique name that you define, and is associated with 
one analysis code, analysis type and element type (such as MSC Nastran / Structural / Shell), Element 
properties that vary reference Fields. For example, thickness that varies spatially would be defined using a field 
(names preceded by f: are field names).

To use the Element Properties Application form:

1. Select Properties from the Patran Main form.

The Element Properties application form appears in your viewport.

2. Select an Action, Dimension, and Type combination at the top of the application form.

The bottom portion of the form varies depending on your selections.

Important:  Element properties are defined with reference to a specific analysis code. Be sure the proper 
code and type have been selected before proceeding, via the Preferences/Analysis menu.
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Actions
The table below describes the actions you may choose on the Element Properties form.
 

Dimensions and Types
The following table lists the dimensions and element types you may select in preparation for an MSC Nastran 
structural analysis. 
 

Action Descriptions

Create Inputs analysis code specific finite element property data and associates that 
data with selected FEM or geometric entities.

Modify Makes any modification desired to Existing Property Sets.

Delete Removes element property sets from the database.

Show Displays tables listing FEM or geometric entities and their associated 
properties. Creates scalar, vector, and marker plots of selected properties.

Dimension Type

0D (Point Elements) Mass, Grounded Spring, Grounded Damper

1D (Line Elements) Beam, Rod, Spring, Damper, Gap, 1D Mass

2D (Plane Elements) Shell, Bending Panel, 2D-Solid, Membrane, Shear Panel

3D (Volume Elements) Solid (Standard or P-element)
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Sample Element Properties Form
The Element Properties form prompts you to specify a property set name, define the application region, and 
set code-specific options.

Exisitng Property Sets The names of previously defined property sets are listed in this listbox.

Property Set Name If you have selected an existing set from the listbox (or from the viewport), 
its name appears here.

Options These Options pop-up menus are analysis code-specific. Refer to the 
documentation for your analysis code for help in making the desired 
selections.

Input Properties Click to display the Input Properties subform for the element type and 
options selected.

Select Members Enter IDs for the entities that you wish to add or remove from the 
Application Region. Type the IDs, or use cursor selection tools. The 
entities can be FEM, ASM, or SGM entities.
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Sample Input Properties Subform
The Input Properties subform prompts you to provide additional required and optional information. 
Following is a sample Input Properties subform. The property names shown without parentheses are required 
by the analysis code.

You will receive an error message if you try to complete an element property that is missing a required input. 
The property names shown in parentheses are optional. You can provide them, if needed, for your analysis 
conditions.
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Overview of the Analysis
Analysis is the gateway between the Patran preprocessing and postprocessing environments and the various 
analysis codes that you can use to analyze a model and generate results. MSC Software provides numerous 
proprietary Application Modules, and also provides Preference interfaces to several popular commercial 
analysis codes. 

In addition, Patran supports custom development of interfaces to third-party or in-house analysis codes using 
customization tools such as PCL.The level of integration between the Analysis application and the solver 
codes is identical for application modules, application interfaces, or user-developed interfaces.

Once you have completed building and defining your analysis model, and you have chosen an analysis code, 
you are ready to complete several steps required to actually submit your model to an analysis code and prepare 
for postprocessing the results. This chapter introduces concepts, definitions, and application examples to 
illustrate those steps.

Brief Overview of Analysis Steps
Following are some basic tasks that will be part of any analysis run:

 Select an analysis code.
 Identify a desired solution type.
 Select a sequence of load cases.
 Select a desired output.
 Submit the analysis.
 Read results files back into Patran, or attach a results file in order to postprocess the results.

Basic Concepts and Definitions
This section provides several topics that are intended to help you set up your analysis project, and also to 
choose carefully the most appropriate options when building an analysis model.

Analysis Codes
You will choose an analysis code based on the objective of your analysis, as well as the software available within 
your company or development group and the standards within that group. You may be required to use 
proprietary analysis codes developed within your company, or you may choose from a variety of available 
programs. 

The following general-focus MSC analysis codes are used frequently with Patran.

 MSC Nastran provides advanced general purpose analysis and optimization capabilities, for both 
linear and nonlinear structural and thermal analyses. MSC Nastran provides a broad range of 
solution types for analyzing stress, vibration, dynamic, nonlinear, acoustic, aeroelasticity, and heat 
transfer characteristics of structures and mechanical components. 



179Chapter 9: Running an Analysis
Basic Concepts and Definitions
 MSC.Marc provides advanced capabilities for nonlinear analysis. This analysis code provides 
solutions for structural, thermal and thermal-mechanically coupled problems that include 
nonlinearities from many sources and advanced material properties.

Application Preferences
Application Preferences are MSC-supplied interfaces to some of the more popular analysis codes. These 
interfaces convert the data in the Patran database into the required analysis code input decks. Consult your 
MSC representative for the latest interfaces available for Patran.

Solution Types
In creating your model database at the beginning of the preprocessing stage, you have already selected an 
analysis code and type, such as MSC Nastran Structural analysis. As part of the Analysis application, you will 
select a solution type and determine what environmental requirements you can meet by setting solution 
parameters correctly.

Solution Types are the different solver code modules offered as part of a particular analysis code and type. For 
example, if you select the MSC Nastran code and structural analysis type, you may choose from the following 
solution types: 
 

Different solution types assume different models of behavior and often are used with particular types of load 
and boundary conditions. Each solution type uses a unique set of equations to solve for 
analysis results. 

Desired Results
A very important part of setting up the analysis with the Analysis application is to define what results data 
you need back from the analysis code. The results requested include displacements, stresses, strains, and so 
on. These results will eventually go through postprocessing and be displayed in graphs, plots 
and reports. 

Many of the analysis codes provide some kind of Output Request subform on which to request particular 
types of results. Within MSC Nastran, for example, there are Basic and Advanced Output Request forms. 
The Basic form is shown as an example later in the chapter. It retains the simplicity of allowing you to specify 
output requests over the entire model. A default set of output requests is always preselected

MSC Nastran Structural Solution Types

Linear Static Complex Eigenvalue

Nonlinear Static Frequency Response

Normal Modes Transient Response

Buckling Nonlinear Transient

Implicit Nonlinear Explicit Nonlinear
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Setting Up the Analysis
Different analysis codes, types, and solution types support different sets of element shapes, nodal 
configurations, material properties, element properties, and loads and boundary conditions. When you start 
your model database and select an analysis code, the Patran application forms will only allow you to select 
options supported by that code. You may switch between analysis codes, but this will require you to redefine 
many portions of your model.

The Analysis Application Form
Once you have finished building your finite element model, use the Analysis application form to define and 
initiate the analysis.

To use the Analysis Application form:

1. Select the Analysis button on the Patran Main form.

The Analysis application form appears in your viewport.

2. Select an Action, Object, and Method from the top of the application form.

3. Check the analysis code and analysis type.

The currently selected analysis code and type appear near the top of the form for informational purposes. To 
change these selections, display, then modify the Analysis Preferences form by choosing Preferences/Analysis 
from the Patran Main menu.
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Actions
The available selections for Action depend on the analysis code selected. Typically they include Analyze, Read 
Results, and Read Input. For the purposes of setting up your analysis, the action you select will be limited 
only to Analyze. 

Objects
The object you select defines what part of the model to include in the analysis--Entire Model or Current 
Group. In most cases Entire Model will be your choice.

Methods
The Method you select defines how far the analysis will go. Settings include Full Run, Check Run, Analysis 
Deck, and Model Only. If you select Full Run, any required forward translation is done, then the analysis 
solver is invoked to run the problem.

Sample MSC Nastran Analysis Application Form
For Application Modules, the Analyze action causes the model to be submitted directly for analysis. For 
Application Preferences, Analyze causes the forward translator to create an input deck that you may then 
submit for analysis. The following sample form initiates a MSC Nastran analysis.

Sample Analysis Application form
The sample forms shown here are for an MSC Nastran structural analysis on the entire model.
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Available Jobs Lists all jobnames currently defined for the selected analysis code.

Jobname Defines the name to be attached to all files associated with this particular analysis 
run. 

Job Description Specifies the title to be used in the analysis run for the currently selected job. 

Translation 
Parameters

Displays the Translation Parameters form to specify information required to 
create an input deck for an application preference. 

Solution Type Displays the form to select a Solution Type. 
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Sample MSC Nastran Solution Type Subform 
Selecting the Solution Type unfold box on the Analysis application form brings up the Solution Type subform 
shown below. Use this form to define the type of analysis solution for the analysis.

Running the Analysis
How you run the analysis using the Patran Analysis application forms varies tremendously depending on 
which analysis module or preference you select, and the type of analysis you will run. Shown below are three 
different scenarios for an analysis with MSC Nastran. Each scenario illustrates how you would submit the 
analysis based on different solution types and load cases. 

Direct Text Input Displays a form to define parameters for inputting a Bulk Data deck.

Subcase Create Displays a form to create specific subcases for the analysis.

Subcase Select Displays the Subcase Select form to activate or deactivate different subcases.
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To submit a single load case, linear static analysis job to MSC Nastran:

1. Click the Apply button on the Analysis application form. 

Appropriate defaults and selections will be made automatically. 

To select other solution types or multiple load cases, you will need to access one or more lower-level subforms. 

To complete a multiple load case, linear static analysis:

1. Open the Subcase Select form and select subcases with the same names as the user-defined load case 
names for inclusion in the job. 

To change a parameter for a subcase, such as an output request, you must access the Subcase Create 
form, select a subcase, and bring up the appropriate form to make changes (such as Output Request). 

2. Select the Apply button.

To select a different solution type from linear static,:

1. Bring up the Solution Type form and make the appropriate selection. 

You may then access a lower-level Solution Parameters form from the Solution Type form to change 
parameters that affect the overall analysis. Subcases are created automatically for each defined load 
case. You can select these on the Subcase Select form or modify them on the Subcase Create form. 
The terms load case and subcase are interchangeable. 

2. Click on the Apply button

Monitoring the Analysis
If you are running an analysis with the MSC Nastran application module, the standard default method of 
receiving updates as to how the analysis is progressing is from a separate command window. Should any 
problems arise during the analysis, a red-flagged error message appears in the history area and a separate 
window with the diagnostic message appears on your screen. Once the analysis is complete, you will be 
notified in this area.

In order to see this command window on Windows platforms it is necessary to start Patran using the “-stdout” 
flag. On Linux, the invoking window should have these messages dumped to it as it is the output for standard 
output. If nothing appears in this window, most likely the P3_TRANS.INI file is not configured correctly. 
Consult the Patran Installation and Operations Guide for more information.

Another mechanism to monitor the analysis is to use the Patran Analysis Manager application which requires 
separate installation and configuration.

Retrieving the Analysis Results
Following an analysis, you need to read the results files back into Patran or attach a results file for Patran to 
access. The way to retrieve the analysis results depends on the analysis module or preference you 
are using.

To use the Analysis Application Form to Retrieve Results:

1. On the Analysis application form, select an Action, Object and Method combination.
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The rest of the form varies according to your selections.

2. Click on the Select Results File unfold box.

Select the results file to read in or attach.



Patran User’s Guide
Verifying the Analysis

186
Actions
When retrieving results, the action choices are limited to a couple of choices, depending on the analysis code 
you are using. For example, using MSC Nastran you can select Read Output2 or Attach XDB. By default 
Patran looks for the Attach XDB file.

Objects
The object specifies what you are retrieving. Again using the example of MSC Nastran, you have the option 
of results entities, model data, or both. For the purposes of results, you would select Results Entities.

Methods
The method defines how the results are read or attached. For most purposes this selection is local.

Verifying the Analysis 
Different analysis codes provide different means to ensure quality in your analysis results, as described in the 
documentation for the code. However, some guidelines for what to look for in order to ensure quality are 
provided here.

 Error messages. Each analysis code provides its own set of runtime error messages and feedback after 
the analysis has completed. These must be monitored to flag serious error conditions. For example, 
within MSC Nastran the optional Analysis Manager module provides extensive feedback about error 
conditions. It produces a measure of the numerical accuracy of a finite element model, Epsilon, that 
you can check after a structural analysis. An Epsilon value of less than 10-9 is acceptable.

 Convergent results. Your analysis model should return consistent results after a reasonable amount 
of time. If your analysis does not reach consistent results after a number of iterations, a problem with 
the analysis setup or with some area of the analysis model exists.

 Large gradients of results data. If large changes in displacement or stress within a small region of the 
model occur, go back and create a finer mesh in those areas. 

 Consistency with real-world results data. If actual testing with prototypes or complete products has 
been done, compare your analysis simulation results with real world results.

 Consistency with your expectations for the results. You will often expect a likely result from your 
analysis, and are looking for precise quantification of failure threshold information. If the results 
from your analysis run vary substantially from your expectations, an error in the model or analysis 
setup may have occurred.

How to Resolve Results Problems
If one or more of the items listed above indicates problems with the quality of your analysis results, you must 
go back and reevaluate your model building choices. Likely problem areas will differ depending on the type 
of model you are testing and the analysis code you are using. Refer to your analysis code documentation for 
further information. Following are a few causes of results errors:

 Missing elements.
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 A stiff element next to a flexible one.
 Incorrectly modeled beam/plate, beam/solid, or plate/solid connections.
 Incorrectly modeled offset beams.
 A mesh that is not divided up finely enough into constituent elements in key areas where loads are 

applied. 
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Overview of Results
Finite element results generally take the form of numbers, such as the amount of stress or strain at each node 
point in the model. However, it is difficult to gain a real understanding of how a model behaves by looking 
at a stack of numbers on paper. The ability to visualize results using computer graphics, animation, and other 
results tools has made computer-aided analysis practical for a much wider audience of people, by providing 
a real, visual sense of a model's behavior. 

The Results application in Patran takes a dual approach to this kind of visualization, known formally as 
"postprocessing":

 The most common result display and animation capabilities are bundled on a single, easy-to-use 
menu option requiring little more than the selection of results values and display techniques. 

 Other menu options provide a broader range of results display and output techniques, combined 
with greater flexibility in areas such as managing results values, deriving results, and controlling 
attributes of your display. 

Overall, interactive results display represents the link between a finite element analysis and your engineering 
judgement. By looking at results, such as color-coded results displays, deformed shapes, animations of how 
your model moves, and reports of numerical results values, you gain the insight needed to verify or improve 
your design. 

Basic Concepts and Definitions
Analysis results values are highly specific to the type of analysis, what options you have set, and the analysis 
software used. Hence, the results that you receive and the form that they are in depends a great deal on the 
analysis and not on Patran. At the same time, the Patran results interface will input results in a common 
format for use in its postprocessing menu forms. 

It is important to note that analysis results are not read in during postprocessing (e.g., using the Results 
Display form). Instead, they are read in or referenced following the Analysis, using the Analysis menu form. 
In the event that you have entered a postprocessing menu form and see no result cases available for display, 
the chances are good that either the analysis itself did not complete, or Patran cannot locate the appropriate 
results file.

Types of Analysis Results
Most analysis results take one of three forms: scalar, vector, or tensor values. 

 Scalar results are comprised of a single variable, such as the temperature at a point. A scalar result 
also can be (and often is) a component value of a multi-dimensional result, such as the X-component 
of the displacement vector or the magnitude of the stress at a point. Scalar quantities can be 
displayed by techniques such as color-coded fringe plots, where the color corresponds to the result 
value, or used as variables in an X-versus-Y graph of result values.
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Figure 10-1  Color fringe plot of scalar result values

 Vector results are three-dimensional quantities linked to the components of a coordinate system--in 
other words, results which are spatial in nature. Vector results may include quantities, such as 
displacement, stress, or electromagnetic field values. Spatial vector results such as displacements, can 
be shown using a deformed shape plot that exaggerates the displacements applied to the model, or a 
marker plot that displays symbols corresponding to the vector quantity at each of several points in 
the model.
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Figure 10-2  Deformed shape plot of vector quantities

 Tensor results can be viewed as a "vector of vectors," and commonly occur when there is an 
interdependence between vector quantities. A good example of a tensor quantity in a structural 
analysis is shear stress, for example, with components related to individual or pairwise combinations 
of each of the principal coordinate directions. Tensor fields consist of nine values at each discrete 
point within the model, and can be displayed as marker plots. Actual tensor values can also be 
displayed.

Result Cases
Result values are grouped into what are called result cases, containing all of the results data for one step of the 
analysis. These steps could consist of individual static load and boundary condition cases, for example, or 
may represent results at individual time or frequency points within these solution domains. No matter what 
the source of the analysis results, Patran generally displays one or more result cases within its results menus.

Even when there is only a single result case available, one result case must be selected before results display 
can be performed. Once a result case is selected, a list of which results are available for this case is shown in 
another menu field.

Depending upon which type of results display is being used in Patran, an appropriate result type must be 
selected. For scalar displays of vector quantities such as stress or displacement, an additional field will allow 
you to select the component of this result, for example, the equivalent stress or the X component of a 
displacement.

Some of the more advanced display options in Patran enable you to derive further results from these analysis 
results, such as a combination of two result sets. This is performed using an optional menu from these forms. 
First, however, it is important to understand how to create basic results images from the data you get directly 
from your analysis program.

Graphical Displays of Result
You can visualize your numerical results using three basic types of displays.

 Fringe plots. These plots are similar to a topographic map, in that they use color to show scalar 
result values on the surfaces of a model. Each color represents a particular range of values, and the 
boundaries between colored regions can be seen as lines of the constant result value at each range 
boundary. In general, "hotter" colors (such as red) represent higher result values while "cooler" 
colors (such as blue) represent lower values, although this can be changed by modifying your 
spectrum, discussed later in this chapter.

 Deformed shape plots. For problems where there is deformation in the model, a deformed shape 
plot shows the model in its deformed position. By default, a scaling factor is used to exaggerate these 
displacements for better visibility, and this factor can be either a multiplier of actual displacements 
or a value that can scale the maximum displacement to a percentage of the screen size. 

 Animation of fringe and/or deformed shape. When you select the Animate option, an animated 
display is produced that varies the fringe plot from zero (all white) to its full color values, and varies 
the deformed shape from rest to its fully deformed position. 
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The Patran Results application gives users control of powerful graphical capabilities to display results 
quantities in a variety of ways. The Results application treats all results quantities in a very flexible and general 
manner. For maximum flexibility, results can be sorted, reported, scaled, combined, filtered, derived, or 
deleted. 

The Results Application Form
The Results application provides various different plot types for results visualization. These plots, sometimes 
referred to as tools or plot tools, allow graphical examination of analysis results, using a variety of imaging 
techniques and also simultaneous display of multiple plots to aid in the understanding of interactions 
between results.

To use the Results Application form:

1. Select Results from the Patran Main form.

The Results application form appears in your viewport.

2. Select an Action and Object from the drop-down menus at the top of the form.

The bottom portion of the form varies, depending on your selections.

Actions
You can select the following actions on the Results application form: create, modify, post, and delete.
 

Action Descriptions

Create Creates new visual results display.

Modify Makes any change desired to an existing plot.
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Objects
The following table summarizes the plot Objects available. 
 

Sample Basic Quick Plot Results Display
For most common results displays, the Quick Plot option of the Results application can be used to quickly 
create the display. In many cases, this simple menu is all that is needed to display your Patran results. 

Choosing a fringe result will generate a color-coded plot of the value. Since fringe plots correspond to scalar 
values, selecting a vector or tensor value will produce additional options for choosing which scalar component 
you wish to display. 

Choosing a deformation result will produce a deformed shape plot, with or without a fringe plot, based on 
the deformation quantity chosen. The deformation values chosen will be multiplied by a default scale factor 
based on your maximum model dimension, to allow the deformed shape to be seen more clearly. 

Post Displays or removes a plot from the viewport.

Delete Removes plots from the database.

Plot Description

Quick Plot A quick deformation or fringe plot using default settings.

Deformation Display of the model in a deformed state. 

Fringe Contoured bands of color representing ranges of results value.

Contour Colored contour lines representing result values.

Marker Colored scaled symbols representing scalar, vector or tensor plots.

Cursor Labels for scalar, vector or tensor quantities are displayed on the model at 
interactively selected entities.

Graph XY plots of results versus various quantities. Results can be plotted against other 
results values, distances, global variables or arbitrary paths defined by geometric 
definitions such as a curve. 

Animation Not technically a plot type; however, most plot types can be animated in a 
modal or ramped style or in a transient state if more than one result case is 
associated with an particular plot type.

Report Also not technically a plot type; however, report definitions of results are stored 
in the database like any other plot tool type, and can be created and modified 
to write reports to text files or to the screen.

Results You can combine and derive results, or you can create fictitious results for 
testing and demonstrating possible outcomes.

Freebody These are freebody diagrams, plotted specifically from MSC Nastran grid point 
force balance results. 

Action Descriptions
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(Alternatively, the full Deformed and Fringe menu options of the Results Application allow you to set a 
specific deformation scale factor.)

Display Attributes Provides access to Display Attribute option forms.

Select Result Cases Selects the desired Result Case. This fills out the Fringe Result and 
Deformation Result listboxes below. If this listbox is empty, no results exist in 
the database. Results are imported from the Analysis application.

Select Fringe Result Selects a result type from which to make a fringe plot, if desired.

Select Deformation 
Result

Select a displacement results from which to make a deformation plot, if 
desired. If a fringe plot is also selected, it will appear on the deformed 
structure.
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Sample Deformation Plot
There are many different ways to observe and interpret the results of an analysis, both graphically and 
numerically. In addition, other results display options beyond the Quick Plot form allow much greater 
control over results data, type of display, and plot options. These options are brought up by setting the Object 
field of the Results application to one of the other available results display options. 

To create a deformation plot:

1. Set the Action to Create and select an Object (the plot type) from the Results application form.

2. Select a Results Case from this listbox.

3. Select a result associated with the Results Case from this listbox.

4. Press the Apply button on the bottom of the form

.
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Using Other Results Display Options
The previous samples represent just a couple of options available for this display, and controls basic selection 
of results. Other attributes such as target display entities, display attributes, and plot options are available 
through the other option button icons on this form, discussed in the following section. 

The general procedure for performing a Results postprocessing operation is as follows: 

 Set the Action to Create. 
 Select the Plot or Result type, using one of the options described below. 
 Select the result type and result. 
 Modify target entities, display attributes, plot or animation options as desired. 
 Pick Apply to generate and/or post the results.

Beyond the capabilities of the Quick Plot option, Results operations available in Patran include 
the following: 

 Deformation. Produces a deformed shape of the model, as described above, with full control over 
attributes such as scaling factor, rendering style, and results used. 

 Fringe. Produces a color fringe plot, as described above, with full control over many display and 
results attributes.

 Contour. Produces colored contour lines of selected styles (e.g. solid, dotted, dashed) for the selected 
scalar quantities.

 Marker. For scalar and other vector and/or tensor quantities such as stress, shear stress, and field 
variables, Marker plots provide capabilities for displaying these quantities as scaled symbols on the 
display. These quantities can be displayed at nodes or element centroids, and also within the 
elemental or principal coordinate system.

 Cursor. The user selects Scalar, Vector or Tensor Cursor plots. This is an interactive tool for which 
one, three or six result value labels are displayed at the selected entities for scalar, vector or tensor 
quantities, respectively.

 Graph. Most scalar results quantities can be used as independent variables for XY graph displays, 
plotted against variables such as time, frequency or other results values. Aside from the XY plotting 
capabilities in Patran’s results menus, you can also use individual curves by name in Patran's general 
(XY Plot) menus, integrated with other curves for displays such as predicted versus actual results, or 
results from multiple problems.

 Animation. This form allows the animation of a previously posted, non-animated results image, 
such as a fringe or deformed shape plot. Alternatively, a non-Quick Plot results display can be 
animated at the time it is generated, using the Animate pick and optional Animation Options form 
(described below) on the menu forms for most results display options.

 Report. Numerical results can be output to files for print or as input for other applications. 
 Results. This form allows you to derive a new results case from the result cases already in your 

database, or create demonstration results that allow you to explore Patran results display operations 
without the need for an actual analysis. Results creation methods include maximum, minimum, 
sum, average, and creation via a PCL function. 

 Freebody. This option creates a free body diagram of loads and reaction forces.



Patran User’s Guide
Postprocessing Results

198
In general, the approach is similar for generating each of these types of results. The appropriate option is 
specified in the Object field of the Results application. Next, result cases and values are selected, along with 
display-specific options on the form (for example, line width or rendering method for a deformed shape 
display. Finally, the display is generated by selecting the Apply button. 

A wide variety of options for control of these results displays are also available as icon buttons on these menus, 
and are described in more detail in the following section. Aside from the Create action choices listed above, 
results displays can also be modified, posted to a viewport, or deleted using other Action selections from the 
Results application menu. 

Results Options 
For each of the Results display methods described above, options exist to control many aspects of these results 
operations, such as display attributes, animation options, or targeting of results to specific entities. These 
option menus are accessed through icon buttons on each individual Results form, with buttons appropriate 
to that operation. Some of the options available include: 

Beyond these most common options, other method-specific icons exist, including fringe and deformation 
options for the Quick Plot form, and data save and spreadsheet options for the Report function. 

In addition to these options, other aspects of your result display can be controlled from the Display options 
of the main menu. These include:

 Ranges. The Display/Ranges menu allows you to control the range of results mapped to your 
spectrum of colors.

Select Results. This default option allows you to select what form of result to display (scalar, 
vector, or tensor), and what component(s) will be used for lower-order display of vector or 
tensor data. 

Target Entities. This option allows you to filter results based on value ranges or attributes 
such as material properties, element types, element properties, or entity numbers. 

Display Attributes. Method-dependent display parameters such as line width, rendering 
style, and scaling factors.

Plot Options. A method-dependent set of options for each particular type of plot. For 
example, the Plot Options button for the Create/Fringe option controls items, such as 
coordinate transformations, result averaging and extrapolation.

Animation Options. Controls animation attributes, such as modal versus ramped deformed 
shape animation, number of frames, and frame-to-frame interpolation technique.
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 Spectrums. The Display/Spectrums menu allows you to specify which colors are used in results 
display, and multiple spectrums can be stored and managed. The default spectrum goes from "cool" 
colors such as blue, for low values, to "hot" colors such as red, for high values. You can change these 
values to better reflect specific result thresholds, or to better reflect both peak positive and negative 
values.
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